
1 

 

 

 



2 

 

 

 



3 

 

C U P R I N S 

ASPECTE INTRODUCTIVE ....................................................................................... 5  

1.TEHNOLOGIA INFORMAŢIEI ŞI COMUNICAŢIILOR (TIC). INIŢIERE. 

 NOŢIUNI GENERALE.………………………………………………………...…….6  

1. 1.ISTORIA DEZVOLTĂRII CALCULATOARELOR(1)....................................... 7  

1.2. COMPONETELE UNUI PC.................................................................................. 9  

1.3.SISTEM DE OPERARE..........................................................................................12  

1.4.LANSAREA SO WINDOWS................................................................................. 14 

1.5.TASTE OPERATIVE..............................................................................................16 

2.MS OFFICE WORD 2007. INIŢIERE.........................................................................20 

3.MS OFFICE WORD 2007. LUCRU............................................................................. 23 

3.1.OPERAŢII CU DOCUMENTE............................................................................... 24 

3.2.MODALITĂŢI DE SELECTARE UNUI CARACTER, CUVANT, PARAGRAF, 

TEXT.............................................................................................................................. 25 

3.3. COPIEREA/MUTAREA TEXTULUI ÎN ACELAŞI DOCUMENT SAU ÎN ALTE 

DOCUMENTE DESCHISE........................................................................................... 26 

4.FORMATAREA CARACTERELOR. FORMATAREA PAGINII......................... 26 

4.1. FORMATARE TEXT........................................................................................ 27 

4.2. MACROCOMENZI........................................................................................... 28 

5.LUCRUL CU OBIECTE ÎN WORD........................................................................... 29 

5.1. GRAFICĂ ÎN DOCUMENTE TEXT................................................................30 

5.2. INSERAREA UNUI OBIECT............................................................................30 

5.3. IMPRIMAREA...................................................................................................30 

5.4. VERIFICAREA ORTOGRAFICĂ A DOCUMENTULUI............................... 30 

5.5. OPERAŢII DOCUMENTE............................................................................... 30 

6.PREZENTARE INTERFAŢĂ MICROSOFT EXCEL 2007.................................... 31 

6.1. MICROSOFT EXCEL 2007 - INTERFAŢĂ.................................................... 32 

6.2. GESTIONAREA DATELOR DIN FOILE DE CALCUL................................ 32 

6.3. INTRODUCEREA ŞI MODIFICAREA INFORMAŢIILOR.......................... 33 

6.4. GESTIUNEA CELULELOR /RANDURILOR /COLOANELOR /   



4 

 

FOILOR   ELECTRONICE DE CALCUL...............................................................33 

6.5.REDIMENSIONAREA RÂNDURILOR / COLOANELOR............................. 34 

7. FORMULE ŞI FUNCŢII ÎN EXCEL…………………............................................. 35 

8. LUCRU CU DIAGRAME ÎN MICROSOFT EXCEL 2007......................................36 

8.1. OPERAŢII ASUPRA DIAGRAMELOR............................................................38 

9. REŢELE DE CALCULATOARE................................................................................39 

10. INTERNET. POŞTA ELECTRONICĂ. MS OUTLOOK........................................48 

11. UTILIZARE MS POWERPOINT 2007 LA CREAREA PREZENTĂRILOR 

ELECTRONICE .............................................................................................................. 51 

11.1. ELEMENTELE DE INTERFAŢĂ................................................................. 51 

11.2. SUPRAFAŢA DE LUCRU............................................................................ 52 

11.3. CREAREA UNEI PREZENTĂRI.................................................................. 52 

11.4. MODIFICAREA /FORMATAREA OBIECTELOR..................................... 54 

SARCINI DE LUCRU................................................................................................... 55 

BIBLIOGRAFIA  ……….............................................................................................. 67 

  

 

 

 

 

 

 

 

 

 

 

 

 



5 

 

ASPECTE INTRODUCTIVE 

Scopul general al disciplinei constă în iniţierea elevilor în problematica informaticii şi 

tehnicii de calcul, formarea aptitudinilor şi competenţelor în studierea generală a mijloacelor 

informatice, în primul rând a aplicaţilor de bază din pachetul Microsoft Office. 

Obiectivul principal al disciplinei „Tehnologii informaționale” îl constituie identificarea 

problemelor de bază ale informaticii şi interpretarea deprinderilor practice de creare şi gestionare 

a fişierelor în programele aplicative de bază. 

La organizarea studierii acestei discipline, profesorul va folosi cele mai eficiente tehnologii 

de predare – învăţare – evaluare. 

Formele şi metodele de organizare a activităţii elevilor vor fi alese şi aplicate în conformitate 

cu asigurarea tehnică şi specificul echipamentului software, capacităţile individuale ale elevilor, 

cu scopul de a asigura cel mai înalt randament la realizarea obiectivelor preconizate. 

Motivaţia, utilitatea disciplinei pentru dezvoltarea profesională 

Culegerea, stocarea, prelucrarea, analiza şi transmiterea informaţiilor sunt activităţi care 

trebuie să folosească eficient şi eficace atât resursele informaţionale şi umane cât și cele tehnice. 

În aceste condiţii viitorii specialiști necesită cunoștințe elementare în domeniul tehnicii de calcul. 

Din aceste motive a fost introdusă disciplina Tehnologii informaționale. 

Sistemele educaţionale din întreaga lume se află sub presiunea crescândă de folosire a noilor 

tehnologii de informare şi comunicare, pentru a-i pregăti pe elevi / studenţi pentru o societate 

predilect informaţională. Mai ales tinerii au nevoie de cunoştinţe şi aptitudini în folosirea eficientă 

a tehnologiilor informaţionale din secolul 21. Într-un domeniu aflat în permanentă schimbare, 

importantă este abilitarea tehnologică a tinerilor, adică, formarea la aceştia de aptitudini de 

utilizare a tehnologiilor, în general, dar şi formare a unei atitudini deschise, receptive la nou, de 

abordare corectă a informaţiilor noi; cu alte cuvinte, aceştia trebuie „învăţaţi să înveţe”. 

Introducerea disciplinei „Tehnologii informaționale” va conduce la dezvoltarea 

deprinderilor legate de accesarea, interpretarea şi prezentarea informaţiilor, de modelarea şi 

controlul evenimentelor. Luând în considerare particularităţile grupului de elevi, nevoile reale de 

formare ale acestuia, procesul instructiv-educativ va ţine cont de specificul învăţării persoanelor 

adulte şi va urmări dezvoltarea abilităţilor necesare secolului XXI. 

Obiectivele disciplinei sunt în concordanţă cu obiectivele prevăzute în strategia pentru 

angajarea forţei de muncă, care pun accent pe dezvoltarea competenţelor digitale ca şi competenţe 

cheie europene. 
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1. TEHNOLOGIA INFORMAŢIEI ŞI COMUNICAŢIILOR (TIC). 

INIŢIERE. NOŢIUNI GENERALE. 

AGENDĂ 

 Istorie apariţie PC. 

 PC. Tipuri de PC. 

 Componentele unui PC.  

 Modul de funcţionare a unui PC.  

 Sisteme de Operare. 

 Sistem de fişiere. 

NOŢIUNI INTRODUCTIVE 

 Calculator, sistem de calcul, computer, PC - este o maşină de prelucrat date și informații 

conform unei liste de instrucțiuni numită program (wikipedia.org). 

 Date – marimi de tipul: numere, litere, imagini, cuvinte,.., ce au o formă statică. 

 Prelucrarea datelor – introducerea în calculator, transmise altor persoane, altor calculatoare. 

 Informația se constituie într-o reprezentare a realității, descrierea datelor. 

 Informatică - ştiinţa prelucrării informației cu ajutorul calculatoarelor. 

UNITATEA DE MASURA A INFORMATIEI 

 1 Bit = Binary Digit: 0 , 1  

 8 Bits = 1 Byte / Octet (01001001)2 = 7310 

 1024 Bytes = 1 Kilobyte = 1,024 bytes 

 1024 Kilobytes = 1 Megabyte = 1,048,576 bytes 

 1024 Megabytes = 1 Gigabyte = 1,073,741,824 byte 

 1024 Gigabytes = 1 Terabyte = 1,099,511,627,776 bytes 

 1024 Terabytes = 1 Petabyte = 1,125,899,906,842,624 bytes 

 1024 Petabytes = 1 Exabyte = 1,152,921,504,606,846,976 bytes 

DEZVOLTAREA CALCULATOARELOR 

 Bazate la început pe tuburi electromagnetice 

 apoi tranzistoare şi circuite integrate pe scară simplă (SSI:sub 20 de tranzistoare pe pastila 

de  siliciu). 

 pe scară medie (MSI:20 – 1000 de tranzistoare pe pastila de siliciu). 

 pe scară largă (LSI :1000 – 50000 de tranzistoare pe pastila de siliciu),  

 pe scară foarte largă (VLSI: 50000 – 100000) de  tranzistoare pe pastila de siliciu) si 

 pe scară ultra largă (ULSI : peste 1000000 de  tranzistoare pe pastila de siliciu).  
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1.1. ISTORIA DEZVOLTĂRII CALCULATOARELOR(1) 

Generatia 0 – calculatoare mecanice – (pînă la 1940) 

 sec. 17 – Pascal – masina de calcul pt. adunare si scadere 

 sec. 17-18 – Leibnitz – masina pentru 4 operatii aritmetice 

 sec 19 - Ch. Babbage (Cambridge)– masina diferentiala si masina analitica (Ada Byron-

prima programatoare) 

-  parti componente: memorie, unitate de calcul, cititor de cartele si perforator de cartele 

 inceputul sec. 20 

- John Athanasoff - sistemul binar de numeratie 

 

 

 

 

 

 

 

ISTORIA DEZVOLTĂRII CALCULATOARELOR (2) 

Prima generatie – 1945-55 

 tehnologie: tuburi electronice 

 1943-46 – P. Eckert & J. Mauchley – ENIAC – primul calculator 

-  18000 tuburi, 1500 relee, 30 tone  

 J. von Neumann – IAS  

- primul care a scris despre calculatoare 

 Variante de calculatoare: 

- ENIAC (Electronic Numerical Integrator And Computer) 

- EDVAC (Electronic Discrete Variable Automatic Computer),  

 IBM 701,704,709 – primele calculatoare comerciale. 

PRIMA GENERATIE DE CALCULATOARE(3) 
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ISTORIA DEZVOLTĂRII CALCULATOARELOR (4)  

Generatia a doua – 1955 - 65 

 tehnologia: tranzistorul 

 Shockley&Brattain – primul tranzistor (Bell labs) 

 primul calculator tranzistorizat: TX-0 

 IBM 7090 – varianta tranzistorizata, IBM 1401 

 Wirlwind – MIT 

 

 

 

 

 

 

 

 

ISTORIA DEZVOLTĂRII CALCULATOARELOR (5)  

Generatia a treia – 1965-75 

 tehnologia: circuite integrate 

 familii de calculatoare: 

- mainframe: IBM 360, IBM 370 

-  mini: PDP  

 imbunatatiri: 

- Viteza 

- dimensiuni mici 

- memorii de capacitate mai mare  

(256k-512k) 

- periferice noi  

ISTORIA DEZVOLTĂRII CALCULATOARELOR (6)  

 Generatia a 4-a 1975- ~’90 

 tehnologia: VLSI (Very-Large-Scale Integration)  

- avantaje: viteza, cost redus, dimensiuni mici 

 aparitia primului microprocesor - Intel 4004 

 circuite de memorie ROM, RAM, DRAM de  

capacitate mare (1-16ko) 

 aparitia microcalculatoarelor – care au la baza 
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un microprocesor 

 aparitia calculatoarelor personale: 

- home-computer: ZX81, Spectrum 

- PC: IBM-PC, XT, AT, Apple, Machintosh 

GENERAŢIA 4 

 

ISTORIA DEZVOLTĂRII CALCULATOARELOR (7)  

Generatia a 5-a 1990 - … 

 Hardware – circuite integrate pe scară ultralargă ULSI 

 Software – SO, tehnologii înalte 

 Memorie de Giga Octeţi 

 Comunicaţii: fibră optică, sputnic, … 

 Viteza de 3 G operaţii /secundă 

  

 

 

 

 

 

1.2. COMPONETELE UNUI PC 

Software (articole fine ce nu pot fi văzute) - sistemul 

de programe. 

- SO Windows, MS Word, MS Excel, …. 

 Hardware (obiecte grele) – componente fizice. 

- HDD, RAM, MatheBoard, … 

 Hardware: 

 Componete auxiliare (mouse, printer,..). 

 Dispozitive de intrare a datelor (tastatura, mouse,.. ). 
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 Dispozitive de ieşire a datelor. (monitor, printer) 

 Dispozitive de procesare a informaţiilor (blocul de 

system) 

COMPONENTE HARDWARE BLOC DE SYSTEM 

 placa de bază 

 case 

 procesorul 

 memoria 

 hard discul 

 placă video 

 placă de sunet 

 placă de reţea 

 Unitate optică 

 sursa de tensiune 

 

 

 

 

PLACA DE BAZĂ (MATHEBOARD) 

 conectează toate componentele din exterior sau din interior 

 Componenta principală a MB este un ansamblu de microcircuite numit chipset cu: 

 funcţia de realizare şi optimizare a transferului de date  între diferitele componente. 

 Chipsetul conţine de regulă două cipuri: 

- NorthBridge – responsabil cu transferul de date de la şi către procesor, placa video AGP sau 

PCI Express, memorie 

- SouthBridge – responsabil cu transferul de date de la şi către hard disk, unităţile optice, alte 

plăci periferice, USB.  

PROCESORUL     

 Este piesa cea mai importantă a unui PC – realizează toate operaţiile de calcul.  

 Caracteristici procesor: 

 frecvenţa de funcţionare: „viteza cu care face calculele” măsurată în MHz sau GHz 

 memoria cache: memoria rapidă existentă pe pastila procesorului ce ajută la efectuarea mai 

rapidă a operaţiilor de către CPU, fără a face apel la memoria sistemului. 

 mărimea de fabricaţie: reprezintă valoarea în nanometri (nm).  

 modelul procesorului: diferă în funcţie de  

producătorul CPU (Intel, AMD).  
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MEMORIA 

 Memoria unui computer reprezintă o componentă a acestuia ce are rolul de a stoca 

pentru anumite intervale de timp datele folosite în calcul. Împreună cu procesorul, memoria 

realizează modelul de bază al unui Calculator. 

 Memoria 

-  Internă (ROM, RAM, CASHE) 

• ROM (Read Only Memory) nevolatilă şi conţine BIOS-ul – set de programe p-u iniţializarea 

şi controlul la nivel de direct al disp.  

Este încărcată din fabrică. 

• CASHE – depozitarea informaţiilor la transportare în / de la procesor. Dacă inf. există în 

cashe siTemul nu mai trebuie să le ia din RAM. 

- Externă (CD-ROM, stick, …) 

-  

RAM 

 RAM (Random Acces Memory – memorie cu acces aleator) volatilă, este “masa de lucru” 

a calculatorului, adică locul unde se efectuază toate operaţiile. 

- Memoria RAM e o memorie rapidă folosită de componentele computerului pentru a stoca 

temporar date. 

TIPURI RAM  

 DRAM (Dynamic RAM): stochează datele pentru un timp foarte scurt înainte de a le pierde. 

Pentru a fi menţinute, sistemul trebuie permanent să le reîmprospăteze. 

 SRAM (Static RAM): memorează datele cât timp e menţinută alimentarea cu energie, fără 

a fi nevoie de reîmprospătarea informaţiei. 

 SD-RAM (Synchronous DRAM): foloseşte o referinţă de timp comună pentru 

sincronizarea dintre procesor şi memorie. Viteza de transfer a datelor e precizată în MHz, 

tipurile uzuale folosite fiind: PC66 SDRAM (66 MHz),  

PC100, PC133. 

 DDR-SDRAM (Double Data Rate SDRAM): este cel mai nou tip de memorie ce 

înlocuieşte vechiul SDRAM. 

 DDR şi DDR2, DDR3 – cea mai nouă tehnologie 

 

HDD 

 Componenta pe care sunt stocate datele cu care lucrează calculatorul. El reprezintă memoria 

nevolatilă 
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 Capacitatea de stocare (20, 40, 60, 80, 100, 250, 500)GB 

 Standarte: IDE, ATA, SATA - diferă viteza de trasfer. 

DISPOZITIVE OPTICE 

 Unitatea de dischetă (Floppy Disk Dirve – FDD) 

 CD-ROM, DVD-ROM, 

 USB Stick 

MONITOR – VIZUALIZARE INFORMAŢIILOR 

 Parametri:  

- mărime – dimensiunea diagonalei monitorului, care se măsoara in inch 

(1inch=2,54cm.). Cele mai intalnite mărimi: 14 inch, 15, inch, 17 inch şi 21 inch; 

- rezoluţie – este reprezentată de numărul maxim de puncte din care imaginea se poate forma 

pe monitor. Calitatea imaginii este cu atat mai bună cu cat rezoluţia 

este mai mare. Rezoluţiile folosite frecvent pentru monitoarele sistemelor de calcul sunt: 

800x600 pixeli 1024x768 pixeli; 1280x1024 pixeli şi 1600x1200 pixeli; 

- frecvenţa de lucru – măsurată in Hz, reprezintă viteza cu care se reimprospăteaza imaginea 

pe monitor inr-o secundă. 

-  

1.3. SISTEM DE OPERARE 

 Un sistem de operare constă dintr-un ansamblu de proceduri manuale şi module de 

programe de sistem, care administrează resursele sistemului de calcul,  

asigură utilizarea eficientă în comun a acestor resurse şi oferă utilizatorului o interfaţă cât mai 

comodă pentru utilizarea sistemului de calcul. 

 Îndeplineşte rolul de interfaţă între hardware şi utilizatori.  

 Oferirea posibilităţii de pregătire şi lansare în execuţie a programelor. 

 Alocarea resurselor necesare executării programelor, realizată prin identificarea 

programelor, a necesarului de memorie, a dispozitivelor periferice şi a cerinţelor privind 

protecţia datelor. 

TIPURI DE SISTEME DE OPERARE 

2 tipuri de sisteme de operare: 

 monotasking, care execută un singur program la un moment dat; (MS-DOS) 

 multitasking, la care nucleul sistemului de operare trebuie să asigure suplimentar 

partajarea timpului între programele ce se execută şi gestiunea alocării resurselor sistemului. 

 Windows este un mediu multitascking – simultan se execută mai multe programe  

MS-DOS, OS/2,UNIX, Windows 3.1, Windows NT, 95, 98, 2000, XP, VISTA, 7,8, Server 

2003, Server 2008,..  
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INTERFAŢĂ UTILIZATOR 

  UI - componenta de  

interactiune dintre SO si user.  

 Interpreteaza apasarea unei 

taste a tastaurii, un click de  

mouse pentru programele 

respective.  

 O interfata utilizator grafica 

(GUI) permite utilizatorului sa 

foloseasca software-ul folosind 

obiecte vizuale precum ferestre,  

meniuri de tip “pull-down” si 

simboluri grafice.  

 

FISIERE 

 Windows - sistem de fisiere ierarhic. 

 Fisierele se afla în containere logice 

 aranjate intr-o structura arborescenta.  

 Sistemul de fisiere incepe cu radacina arborelui. 

 Containere – folder 

FIŞIER 

 O colecţie de date de acelaşi tip identificată prin nume 

şi extensie.  

2

Numele fişierului : 

 Maxim 255 caractere 

 Nu permite utilizarea 

caracterelor / \ :?*<>| si 

a caracterelor naţionale 

Ex. file. txt, … 

Numele fişierului : 

 Maxim 255 caractere 

 Nu permite utilizarea 

caracterelor / \ :?*<>| si 

a caracterelor naţionale 

Ex. file. txt, … 
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FOLDERE 

 Un folder este un fişier special care conţine mai multe fişiere grupate după anumite criterii. 

 Icon-ul său este un dosar galben: 

 Un folder special se numeşte rădăcină şi este prezent pe orice suport. 

 El are numele unităţii urmat de caracterul backslash “\”Exp: D:\ , C:\ 

 Organizarea informaţiei in directoare şi fişiere poarta numele de arbore de directoare 

1.4. LANSAREA SO WINDOWS 

 Lansarea sistemului Windows finalizează cu  

afişarea pe ecran: 

 Suprafaţei de lucru (Desktop) – fundalul pe  

care apar ferestrele şi pictogramele. 

SUPRAFAŢA DE LUCRU 

 Pictograme (Icons) - simbolizări grafice ale diferitor obiecte Windows. 

 Bara de operaţii (Taskbar) - ce afişează meniul Start şi listele aplicaîiilor (pictogramelor) 

şi documentelor lansate în execuţie. 

 Butonul Start plasat pe bara de operaţii oferă accesul rapid la aplicaţii (programe), 

documente,  

parametri prestabiliţi, tematici, Help,.. 

 Fereastra (My Computer) conţine pictograme ce reprezintă unităţile de disc ale sistemului, 

fişierele şi dosarele calculatorului, panoul de comandă (Control Panel) şi dosarele 

imprimantelor.  

 

SUPRAFAŢA DE LUCRU 

 Vecinătăţile în reţea (Network Neighborhood) este o fereastră ce afişează calculatoarele 

din reţea, permite utilizarea în comun (partajarea) calculatoarelor,  

imprimantelor şi ale altor dispozitive cu utilizatorii reţelei locale la care sunteţi conectaţi. 

 Coşul de hârtii (Recycle Bin) se utilizează pentru stocarea obiectelor şterse. În caz de 

necesitate, aceste obiecte pot fi restabilite. 

 Shortcut – pictograme care conţin referinţe la alte obiecte Windows (programe, dosare şi 

documente). 

FERESTRE 

 Elementul esenţial de afişare în SO Windows. 

 Ferestre– zone dreptunghiulare de pe ecran ce conţin dosare, fişiere, documente, casete de 

dialog, etc 
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 Pe ecran pot fi afişate mai multe ferestre, eventual suprapuse total sau parţial.  

 Fiecare fereastră aparţine unei aplicaţii.  

 Activarea/dezactivarea unei ferestre se face printr-o simplă executare a unui clic cu mouse-

ul (sau Alt+Tab; Alt+Shift+Tab; Alt+Esc). 

 Deplasarea / redimensionarea unei ferestre 

TIPURI DE FERESTRE 

 De aplicaţie - apar de fiecare dată când lansăm în execuţie o aplicaţie.  

 De document - pot apărea doar în cadrul ferestrelor de aplicaţie. Unele ferestre de aplicaţie  

pot conţine mai multe ferestre de document, altele – doar una singură. 

-  Casete de dialog. 

-  Casete de avertizare şi confirmare. 

-  Casete cu liste de selectie. 

-  Casete cu text de inserare 

-  Casete cu butoane de derulare 

PĂRŢILE COMPONENTE ALE UNEI FERESTRE 

1. Butonul meniului Sistem     

2. Bara de titlu  

3. Bara de meniuri 

4. Buton de minimizare 

5. Buton de maximizare 

6. Buton de închidere  

7. Bara de instrumente; 

8. Butoane de defilare pe  

orizontală /verticală  

9. Acsensor vertical /orizontal 

10. Conţinutul ferestrei 

11. Bara de stare 

FOLOSIREA MENIURILOR 

 ALT + prima litera a meniului 

 Optiuni active şi neactive 

 Optiuni cu combinaţii de taste (taste operative). 

MEMORIA CLIPBOARD 

 Intermediar prin intermediul căruia pot fi transferate texte, desene, sunete, etichete, dosare, 

fişiere etc atât în cadrul aceluiaşi document cât şi între diferite 

programe. 
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1.5. TASTE OPERATIVE 

 

 

 

 

 

 

 

 

 

 

 

Combinaţia de taste Acţiunea 

Ctrl+săgeţi, Home, End Trecerea la pictogramele obiectelor unui dosar fără 

ca obiectul să fie selectat 

Ctrl+spaţiu Anularea selecţiei 

Ctrl+Alt+Del Apelarea casetei de dialog Close Program 

Ctrl+Esc Deschiderea meniului de bază Start 

F1 Apelarea programului de asistenţă şi ajutor 

F2 Redenumirea obiectului selectat 

F3, Ctrl+F Se activează programul Find (Găsirea fişierelor şi dosarelor) 

pentru dosarul curent 

F4 Se deschide lista “Trecerea la alt dosar” dacă este instalată bara 

de instrumente. La apăsarea repetată lista se închide 

F5 Se reactualizează conţinutul ferestrei; se anulează regimul de 

selecţie 

F6 Se selectează lista “Trecerea la alt dosar” dacă este instalată 

bara de instrumente. La apăsarea repetată lista se închide 

F10, Ctrl+F10 Se selectează prima comandă din bara de meniuri (colţul de 

stânga) 

Alt+Enter Afişarea proprietăţilor obiectului selectat. Trecerea aplicaţiilor 
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DOS din regim de fereastră în regim de afişare pe întreg 

ecranul şi invers 

Alt+dublu-clic Afişarea proprietăţilor obiectului selectat 

Alt+F4 a) închiderea aplicaţiei active b) afişarea casetei de dialog Shut 

Down Windows (finalizarea lucrului cu din sistemul 

Windows) 

Alt+Tab Comutarea între aplicaţiile active 

Alt+Esc Trecerea la butonul următoarei aplicaţii active, dacă ea n-a 

fost minimizată 

Alt+spaţiu Activarea casetei meniului de control 

Alt+minus Activarea casetei meniului de control a aplicaţiei active 

Alt Alegerea primului punct al meniului 

Alt+literă subliniată Activarea unei comenzi corespunzătoare din meniu. De 

exemplu, consecutivitatea Alt+f+s (meniul File, submeniul 

Save) activează comanda Save a meniului File 

Shift+F10 Afişarea meniului contextual 

Shift+Alt+Tab Trecerea la precedenta aplicaţie activă 

Shift+Del Ştergerea obiectului selectat fără plasarea lui în coşul de hârtii 

(ştergere definitivă) 

Tab Trecerea la următorul parametru, grup de parametri ori 

următorul câmp al ferestrei de dialog 

Shift+Tab Trecerea la precedentul parametru, grup de parametri ori 

precedentul buton 

Esc Anularea tuturor parametrilor selectaţi 

Spaţiu Alegerea unui element din listă de opţiuni 

Shift+săgeţi, Home, End Selectarea obiectelor 

Del Ştergerea obiectului selectat cu plasarea lui în coşul de hârtii 

Backspase Trecerea în ierarhia arborescentă la un nivel mai superior 

 

Literă Pe suprafaţa de lucru: trecerea la următoarea 

pictogramă denumirea căreia incepe cu litera dată 
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APLICAŢIA WINDOWS EXPLORER 

Executati clic-dreapta pe  

butonul Selectaţi Explore 

Desktop reprezintă nivelul cel  

mai înalt în ierarhia sistemului de  

fişiere. Urmează My computer, 

unităţile de disc, apoi dosarele  

discului activ. Activizarea unei  

unităţi de disc se face prin  

executarea unui clic pe  

pictograma respectivă; în mod  

analog pot fi deschise dosarele.  

CĂUTAREA ÎN SO WINDOWS 

În bara de instrumente  

Căutare. 

Poate fi căutat un fişier  

sau un dosar tastând  

Tools, Find apoi Files 

or Folders (sau F3).  

Apare caseta de dialog  

Find. Căutarea poate fi 

efectuată după toate 

criteriile indicate în  

casetă.  

 

PANOUL DE CONTROL (CONTROL PANEL ) 

Lansarea aplicaţiei Panoul de Control se face: 

- o executăm un dublu-clic pe pictograma respectivă din fereastra Calculatorul Meu sau 

Windows Explorer; 

- o parcurgeţi calea Start/ Settings/ Control Panel.Panoul de Control reuneşte un set de aplicaţii 

(programe) destinate pentru ajustarea şi gestionarea diferitor componente ale sistemului 

Windows, inclusiv afişajul, şoricelul, data şi timpul, tastatura etc. Fiecare parametru pe care 

îl puteţi adapta cerinţelor este reprezentat de o pictogramă în Control Panel care se deschide 

într-o casetă de dialog. Lansarea aplicaţiilor se face prin executarea unui  
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dublu-clic pe pictogramele respective.  

PANOUL DE CONTROL (CONTROL PANEL ) 

Modificarea datei şi timpului 

 

 

 

 

 

PANOUL DE CONTROL (CONTROL PANEL ) 

modificarea suprafeţei de lucru  

 

 

 

 

 

 

MODIFICAREA MENIULUI DE BAZĂ START 

 Puteţi adăuga programe des  

utilizate meniului Start,  

pentru a le putea accesa mai  

rapid în mai multe moduri: 

 Start /Settings/Taskbar 

(Bara de operaţii)/ Taskbar 

Properties/ Meniul Start.  

Apoi executaţi clic pe  

Particularizare/Add 

 Sau clic-dreapta pe bara de  

operaţii, va apare caseta de  

dialog Taskbar Properties 

Selectaţi Particularizare ... 

FINALIZAREA LUCRULUI CU WINDOWS.  

REÎNCĂRCAREA CALCULATORULUI 

 Finalizarea lucrului poate fi făcută şi prin apăsarea  

combinaţiei de taste Alt+F4. De asemenea, apăsând  

combinaţia de taste Ctrl+Alt+Del, obţinem caseta de 



20 

 

 dialog, din care putem alege opţiunea Shut Down. 

Ultima procedură este utilă mai ales în cazurile când executarea uneia dintre aplicaţiile active 

se suspendă din motive necunoscute, eveniment care implică blocarea întregului sistem. În 

aceste situaţii este necesar să excludem aplicaţia respectivă acţionând butonul End Task din 

caseta de dialog Close Program.  

INFORMAŢII DESPRE CONFIGURAREA CALCULATOARELOR 

 Varianta 1 

- Click dreapta pe (pictograma) My Computer 

- din meniul derulant afişat se alege opţiunea Properties 

 Varianta 2 

 butonul Start se alege calea Settings – Control Panel 

 În fereastra Control Panel se apelează prin dublu clic  

al mouse-ului pictograma System 

 

Laborator - Operatii cu foldere si fisiere 

 Crearea unui fisier .txt /folder personalizat 

 Salvarea unui fişier .txt /folder personalizat 

 Deschiderea unui fişier .txt /folder personalizat 

 Ştergerea unui fişier .txt/folder personalizat 

 Redenumirea unui fişier .txt /folder personalizat 

 Decuparea unui fişier .txt /folder personalizat 

 Copiere unui fişier .txt /folder personalizat 

 Lipirea unui fişier .txt /folder personalizat 

 Creare shortcut unui fişier .txt /folder personalizat 

 Vizualizarea proprietatilor pentru un fişier/folder 

 Creaţi un folder personal. Nume.Prenume 

2. MS OFFICE WORD 2007. INIŢIERE 

AGENDA 

 Componente MS Office. Caracteristici MS Office. 

 Elemente noi în Office 2007 

 Prezentare interfaţă Word 2007 

 Panglica  

 File pe panglică 

 Elemente de control 
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 Butonul office 

 Bara de elemente cu access rapid 

 Mini-bara de instrumente. 

 Sarcini individuale 

MS OFFICE 

• Microsoft Word 

 oferă posibilitatea de a crea, edita, formata, salva şi deschide documente text; 

 documentele create pot include pe lângă text şi tabele,grafică, diagrame etc.. 

 În mod prestabilit fişierele Word 2007 sunt salvate cu extensia docx. 

 Documentele mai pot fi salvate şi în alte formate dintre care amintim Rtf şi PDF. 

• Microsoft Excel  

 este o aplicaţie de calcul tabelar ce oferă posibilitatea de a introduce date, de a le analiza şi de a 

face calcule cu acestea;  

 sunt incluse numeroase funcţii pentru operaţii matematice, statistice, financiare, de baze de date, 

de dată şi timp etc..  

•  Microsoft Access - oferă lucrul cu baze de date printr-o interfaţă simplă; pot fi create şi editate 

tabele, rapoarte, interogări, formulare. 

• Microsoft Outlook - permite scrierea, trimiterea, primirea, citirea de e-mail. 

• Microsoft PowerPoint - permite scrierea, trimiterea, primirea, citirea de e-mail. 

• Microsoft Publisher - aplicație dedicată creării de materiale promoționale și de marketing 

NOU IN MS OFFICE 2007 

 O nouă interfaţă – PANGLICA / RIBBONX. 

 Live preview (click în tabel, apare o nouă filă) 

 Galerie de obiecte îmbogăţită 

 Bara de Menuri îmbogăţite cu opţinuni. 

 Floaţie - bara de instrumente contextuala 

 Extensia documentelor Office 2007 (x) 

 Compatibilitate cu XML. 

PREZENTARE INTERFAŢĂ 

 Microsoft Office Word 2007 este un program de procesare a textului.  

 Lansarea:  Windows – > Програмы -> Microsoft Office -> Microsoft Office Word 2007.  

 Caracteristici: 

- Formatarea simplă a textului sau folosind stiluri predefinite sau definite de utilizator;  

- Formatarea paginii;  
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- Instrumente integrate de corectare gramaticală şi ortografică a textului;  

- Instrumente grafice de stilizare a textului;  

- Instrumente de administrare a corespondenţei  

COMPONENTE DE INTERFAŢĂ 

 Butonul Office;  

 Bara instrumentelor pentru acces rapid;  

 Bara de titlu;  

 Bara de meniu - Panglică ce conţine implicit File 

 Suprafaţa de lucru;  

 Rigla gradată;  

 Bara de stare;  

 Butoanele de vizualizare;  

 Controalele de mărire / micşorare;  

 Bara şi butoanele de derulare orizontală;  

 Bara şi butoanele de derulare verticală. 7 

PANGLICA 

 Elementul principal al interfeţei 

 Să înlocuiţi Panglica, să o scoateţi nu se poate.  

 Pentru a mări spaţiul de lucru, ascundere / afişare panflică - CTRL+F1 

 File nu se adaugă, elemente în file nu se adaugă. 

 Măriţi /micşoraţi dimensiunea filei – observaţi starea  

panglicii şi a filelor. 

 Apariţia unor file noi. 

ELEMENTE DE CONTROL 

 Elementele de control (controale) sunt butoane obişnuite, drop-down butoane, liste, liste 

derulante, butoane cu meniuri, butoane de validare, butoane de opţiune, butoane de grup 

 Sunt unite în grupuri asociate cu tipul acţiunii. 

 În unele cazuri, după apăsarea butonului apare o casetă de dialog. 

 Contoare sunt utilizate pentru a stabili valorile numerice oricăror parametri. 

 Pentru fiecare element de control se poate afişa o sugestie contextuală. 

BUTTONUL OFFICE 

 Butonul "Office" este situat în colţul din stânga sus. 

 Afişează meniul pentru lucrul cu fişiere, lista documentelor recente, precum si comanda pentru 

setările aplicaţiei. 

WORD OPTIONS 
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 Word options - parametrii de setări diferite 

 Word 2003 – Tools ->Options 

 Word 2007 – buttonul Office -> Word options  

 Meniul Popular din Word options  

 Meniul Afisare din Word options  

 Meniul Verificare din Word options  

 Meniul Salvare din Word options  

 Meniul Complex din Word options  

 Meniului Particularizare din Word options  

 Meniul Programe de Completare 

 Meniul Centru de Autorizare 

 Meniul Resurse 

BARA DE ELEMENTE CU ACCESS RAPID 

 Acces rapid la funcţiile utilizate frecvent. 

 Conţine implicit trei butoane: salvare, anulare, anulare anulare. 

 Poate fi particularizată. 

MINI-BARA DE ELEMNETE 

 Apare la selectarea unui text şi miscare cursor mouse în dreapta sus 

 Conţine elementele care sunt cele mai frecvent utilizate pentru formatarea textului din 

document. 

 Activare / dezactivare  

Butonul Office >Optiuni Word >Populare> Afisare  

minibara de instrumente la afisare. 

3. MS OFFICE WORD 2007. LUCRU CU DOCUMENTE. 

AGENDA 

 Operaţii cu documente. Acordarea permisiunii de modificare a părtilor dintr-un document 

protejat. 

 Afişarea, ascunderea caracterelor neimprimabile 

 Introducerea informaţiilor /Simbolurilor Speciale în documente. 

 Modalităţi de selectare unui caracter, cuvant, paragraf, text. 

 Editarea/Stergerea conţinutului unui document. 

 Folosirea comenzilor „Anulare” şi „Refacere” 

 Copierea/Mutarea textului în acelaşi document sau in alte documente deschise. 

 Comenzi de căutare şi înlocuire a unui text in document. 
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 Formatarea caracterelor. 

 Inspectarea documentelor pentru date ascunse 

 Sarcini individuale 

 

3.1. OPERAŢII CU DOCUMENTE 

 Butonul Office  

- Documente recente 

-  Creare 

-  Deschidere 

 Pentru a proteja documentul Word: 

În fereastra Salvare ca daţi clic pe Tools → General Options pentru a deschide fereastra Opţiuni 

generale. 

- Parole pentru deschidere, redactare,.. 

 Copie de rezervă:  

Buton Office → Parametri Word → Advanced → zona Save  

→ se bifează Always create backup copy. 

•  numefişier.wbk 3 

OPERAŢII CU DOCUMENTE (2) 

 Salvări periodice la un interval de timp stabilit de utilizator. 

Buton Office → Word Options → Save şi se bifează caseta Save autorecover Information every. 

Valoare de timp: 1 şi 120 min.  

Atentie: Recuperarea automată nu inlocuieşte comanda Save – este necesar in continuare să salvaţi 

documentul odată ce aţi terminat de lucrat cu el. 

OPERAŢII CU DOCUMENTE (3) 

 Acordarea permisiunii de modificare 

În fila Review, în grupul Protect, faceti clic pe Protect document, apoi Limit formmating to .. 

 Marcare ca final  

Click pe Office Button, apoi optiune Prepare, apoi Mark as Final. 

 Comutarea între mai multe documente deschise.  

Fila View →Arrange All 

 Schimbarea modului de vizualizare a paginii. 

În fila View, grupul Document Views  

 

OPERAŢII CU DOCUMENTE (4)  
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 Modificarea scării de vizualizare a unui document Fila View, grupul Zoom. 

 Afişarea, ascunderea caracterelor neimprimabile  

- Din Panglică: fila Home grupul paragraf butonul.  

- Din caseta de dialog Opţiuni Word : Buton Office → Word Options → Display → zona Always 

show these formating marks se bifează √opţiunile corespunzătoare caracterelor ce se doresc afişate 

INTRODUCEREA INFORMAŢIILOR ÎN DOCUMENTE 

 Introducerea textului în document se poate realiza prin: tastare, copiere, mutare, etc.. 

 La apăsarea tastei Enter se creează un nou paragraf. 

 Introducerea caracterelor speciale, a simbolurilor  

Fila Insert → grupul Simbols→ Simbol → More simbols.  

3.2. MODALITĂŢI DE SELECTARE UNUI CARACTER, 

CUVANT, PARAGRAF, TEXT 

 Tastele SHIFT şi CTRL. 

-  O propoziţie se selectează prin Ctrl+clic 

-  Selectarea unui rând se realizează mutând cursorul mouse-ului pe marginea din stânga a rândului 

- Selectarea unui număr de randuri se face prin mutarea cursorului mouse-ului pe marginea din 

stânga a primului rand apoi se execută clic în dreptul rândurilor ce se doresc a fi in selecţie. 

 Tasta CTRL se utilizează p-u a selecta rânduri diferite SHIFT pentru a selecta aceleaşi rânduri. 

 Un paragraf se poate selecta executând triplu clic în interiorul lui sau dublu clic în stanga lui. 

- fila Home→ grupul Editing → Select →… 

- F8 activează modul selecţie Extindere selecţie 

MODALITĂŢI DE SELECTARE 

Apăsaţi această tastă sau combinaţie de taste 

Pentru a extinde selecţia 

Shift+Ctrl+← Până la începutul cuvântului curent (sau al cuvântului anterior, dacă sunteţi la 

începutul unui cuvânt)  

Shift+Ctrl+↑ Până la începutul paragrafului curent (sau cel anterior dacă  

sunteţi la începutul unui paragraf)  

Shift+Home Până la începutul rândului  

Shift+End Până la capătul rândului  

Shift+Ctrl+Home Până la începutul documentului  

Shift+Ctrl+End Până la sfârşitul documentului  

EDITAREA/STERGEREA CONŢINUTULUI UNUI DOCUMENT. 

 Deplasarea punctului de inserţie cu ajutorul mouse-ului  

 Deplasarea punctului de inserţie cu ajutorul tastaturii 



26 

 

 Ştergerea textului 

Tastă sau combinaţie de taste Punctul de inserţie se mută:  

Ctrl+ ← Înapoi câte un cuvânt 

Ctrl+ ↓ Înainte câte un paragraf 

Home La începutul rândului 

End La sfârşitul rândului 

Ctrl+Home La începutul documentului 

Ctrl+End La sfârşitul documentului 

Tasta Acţiunea 

BACKSPACE Ştergerea unui caracter din stanga cursorului 

CTRL+BACKSPACE Ştergere unui cuvant la stanga  

DELETE Ştergerea unui caracter la dreapta  

CTRL+DELETE Ştergerea unui cuvant la dreapta  

CTRL+X Decuparea textului selectat şi inserarea in Буфер  

3.3. COPIEREA/MUTAREA TEXTULUI ÎN ACELAŞI DOCUMENT SAU ÎN 

ALTE DOCUMENTE DESCHISE 

 Copierea textului Fila Home - > Clipboard 

 Copierea textului - CTRL + C, CTRL + V 

 Drag and Drop 

Buton Office → Word Options → Advanced √Allow 

text to be dragged and dropped→ OK. 

 Mutarea textului - CTRL + X, CTRL + V 

4. FORMATAREA CARACTERELOR. FORMATAREA 

PAGINII 

AGENDA 

 Copierea formatului de la un text la un alt text. 

 Aplicarea unui stil existent unui cuvânt, unei linii, unui paragraf. 

 Folosirea despărţirii automate în silabe. 

 Alinierea /Indentarea paragrafelor. 

 Stabilirea, ştergerea şi utilizarea tabulatorilor. 

 Liste numerotate şi marcate. 

 Adăugarea de borduri şi umbriri unui paragraf. 

 Formatarea paginilor. 

 Adăugarea, modificarea unui text în antet şi subsol. 
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 Scrierea sau înregistrarea unei macrocomenzi. 

 Crearea marcaj in document. 

 Crearea unui cuprins. 

 Crearea unui index. 

 Sarcini individuale.  

4.1. FORMATARE TEXT 

 Copierea formatului. Se utilizează Format Painter Fila Home, grupul Clipboard, clic pe Format 

Painter. 

 Aplicarea unui style: 

- Un Style este un set de diferite opţiuni de formatare grupate după un nume, ce este folosit pentru 

a reda aspectul exterior al unui element (text, obiect, simbol,..). 

fila Home → grupul Styles, … butonul More Styles. 

 selectarea rapidă a textelor care au aceeaşi formatare. 

Fila Home, grupul Editing, clic pe Select ->Select Text with similar formating. 

FORMATARE TEXT (2) 

 Despărţirea automată în silabe. fila Page Layout→ grupul Page Setup→ Hyphenation 

 Dacă nu se doreşte despărţirea p-u un paragraf  fila Home → butonul “Mai multe optiuni” din 

grupul Paragraph → fila Line and Page Breaks, apoi se bifează caseta Don’t Hyphenation 

 Alinierea textului. 

Fila Home -> grupul Paragraph ->butoane Align Text Left, Center, Right, Justify. 

 Alinierea textului prin tipărire (click, dublu-click). Buton Office → Word Options → Advanced 

→ zona Editing Options, se bifează √Enable click and Type 4 

FORMATARE TEXT (3)  

 Indentarea textului dintr-un paragraph:  

- Rigla gradată. Pe rigla orizontală sunt patru marcatori. 

- Caseta de dialog Paragraph din fila Home.  

 Tabulatori pentru alinierea textului: 

- Se alege fila Home → grupul Paragraph, →TABS 

FORMATARE TEXT (4)  

 Liste numerotate şi marcate  

-  fila Home → grupul Paragraph se activează prin clic, unul butoanele Marcatori, respectiv 

Numerotare. 

 Schimbarea stilului de marcatori sau numerotări : 

- Bullets(Numbering) → Define new Bullet (Number) format şi se alege varianta dorită. 

 Adăugarea de borduri şi umbriri. 
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- din fila Home → grupul Paragraph, lista de borduri → Borders and Shading. 

FORMATAREA PAGINILOR 

 Margini, dimensiune, orientare, întrerupere,…Fila Page Layout → grupul Page Setup → … 

 Antet şi subsol în un document.fila Insert → grupul Header&Footer → Header | Footer 

-  Comutarea între antet şi subsol: Fila “nou apărută” Design -> grupul Navigation -> Go 

to Footer | Header. 

- Cand se finalizează crearea sau modificarea:  

-  Adăugarea unor campuri in antet şi subsol. Fila “nou apărută” Design -> grupul Insert (ora, 

obiect,.. 

4.2. MACROCOMENZI 

 automatizarea activitătilor frecvent utilizate. 

 Pentru crearea de macro, activaţi fila Developer 

Butonul Office > Word Options > Popular > bifati Show Developer Tab in the Ribbon. 

 Înregistrare macrocomandă: 

În fila Dezvoltator, grupul Code, faceti clic pe Record Macro. 

 Atribuiţi comanda unei taste de comenzi rapide. 

 Utilizarea Visual Basic pentru aplicatii. 

CREAREA MARCAJ IN DOCUMENT 

 Un marcaj în document identifică o locatie sau o selectie de text pe care o denumiţi şi identificaţi 

pentru referinţe viitoare. 

În fila Insert, în grupul Links, faceti clic pe Bookmark. 

 Afisarea parantezelor marcajului in document: Butonul Office -> Word Options ->Advanced -

> bifati caseta show Bookmarks (grupul show document content) -> OK.  

CREARE CUPRINS 

 Un cuprins este creat în baza la Heading1, Heading2, ..fila References ->Table of Contents -> 

Table of Contents 

 Actualizare modificare cuprins 

fila References ->Table of Contents -> Update Table Click dreapta pe cuprins, apoi selectaţi 

Update page number sau Update entire Table.  

CREARE INDEX 

 Un index listează termenii și subiectele discutate într-un document, împreună cu paginile în care 

apar. Pentru a crea un index, marcați intrările, selectați un proiect și  

construiți index-ul.( fila References ->grupa Index-> mark Entry) 

FORMATARE PAGINĂ 

 Adăugarea unei inscriptionări text la un document 
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(Model).Page Layout ->grupa Page Background ->Watermark 

 Aplicarea sau particularizarea unei teme de document.Page Layout ->grupa Themes ->… 

 Linii de semnătură la un document:fila Insert -> grupul Text -> signature Line... 

5. LUCRUL CU OBIECTE ÎN WORD 

CUPRINS 

 Crearea si editarea unui tabel standard 

 Grafică în documente text 

 Verificarea ortografică a documentului 

 Imprimarea 

 Facilităţi de trimitere a unui document Word prin email sau fax 

 Importul datelor din Excel in Word 

 Sarcini practice 

 

OBIECTE WORD 

 În documentele create cu Word se pot introduce  

alături de text şi diferite obiecte cum ar fi: 

 Tabele. 

 Imagini. 

 Diagrame. 

 Imagini. 

 obiecte desenate. 

 

TABELE 

 Crearea unui tabel (cîteva modalităţi) Se alege fila Insert → grupul Tables → Table. 

 Editarea informaţiilor într-un tabel  

Fila design şi Fila layout – ce apar la plasarea cursorului  

în interiorul tabelului  

Inserarea, ştergerea randurilor şi a coloanelor 

Fila layout -> grupul Rows&Columns 

Notă: În situaţia în care un tabel a fost introdus imediat ce s-a deschis un document nou 

(adică deasupra lui nu exista text sau spaţiu liber) atunci, pentru a insera un rand de text 

deasupra tabelului Fila layout -> grupul Merge -> Split table 

(2) TABELE 

 Modificarea lăţimii coloanei şi inălţimii randului 
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 Pentru a se afişa în riglă lăţimile coloanelor sau inălţimile randurilor – tasta ALT+clic 

stînga mouse în rigla gradată.   Fila Layout -> Table - >Properties 

 Efectuarea calculelor în tabel. Fila Layout -> grupul Data ->Formula  

 Conver to text 

5.1. GRAFICĂ ÎN DOCUMENTE TEXT 

 Într-un document Word se pot insera: 

 Imagini - Fila Insert grupul Ilustration -> picture  

 Miniaturi - … -> Clip Art 

 Forme - … -> Shapes 

 Ilustraţii … -> SmartArt  

 Diagrame … -> Chart  

 Casete text - Fila Insert grupul text -> TextBox  

 WordArt - .. -> WordArt 

 Obiecte .. -> Objects 

 Toate acestea se află pe fila Insert.  

5.2. ISERAREA UNUI OBIECT 

 Se plasează cursorul în locul unde trebuie să apară  obiectul grafic, apoi Fila Insert …  

 La crearea unei diagrame se va folosi un tabel din MS.  Excel. 

 Modificarea fiecărui obiect grafic se face prin selecarea obiectului după care în file(lele) 

apărută se selectează opţiunile necesare. 

5.3. IMPRIMAREA 

 Butonul Office -> Print. 

 Print Preview 

 Print Properties. 

 Print Obiecte grafice 

5.4. VERIFICAREA ORTOGRAFICĂ A DOCUMENTULUI 

 Funcţia Verificarea ortografiei este de regulă activă şi ea face ca în text cuvintele scrise 

incorect ortografic, să apară subliniate cu o linie roşie ondulată. Se activează: Office 

Button → Word Options → Proofing → zona When Correcting spelling and grammar 

in Word se bifează / debifează caseta Check Spelling as you type 

Corectarea greşelilor , Fila Revew → grupul Proofing → Spelling 

 Setarea dictionarului limbii necesare, Fila Revew → grupul Proofing → Set Language 

5.5. OPERAŢII DOCUMENTE 

 Facilităţi de trimitere a unui document Word prin email sau fax. (ataşare) 

Office Button → Send → Email (fax) 
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 Importul datelor din Excel in Word 

 Deschideţi documentul Word. 

 Deschideţi registru de calcul Excel. 

 Comutaţi ferestrele apoi copiaţi. 

6. PREZENTARE INTERFAŢĂ  

MICROSOFT EXCEL 2007 

AGENDĂ 

 Prezentarea aplicaţiei Microsoft Excel 

 Registre şi foi de calcul 

 Funcţia „Ajutor” (Help) 

 Introducerea, modificarea şi gestionarea datelor în Excel 

 Gestionarea randurilor / coloanelor / celulelor / foilor de calcul 

 Gestionarea foilor de calcul 

 Formatarea celulelor 

 Utilizarea stilurilor de celulă, tabel 

 Protejarea datelor 

 Formatarea condiţională 

 Copierea înformaţiilor 

    MICROSOFT EXCEL 2007 - PREZENTARE 

 Aplicaţie pentru calcul tabelar. 

 Permite prelucrarea datelor organizate sub formă de tabele în foi de calcul electronice. 

 Facilităţi ce oferă Excel: 

- Calcule utilizând formule simple sau complexe; 

- Schimburi de informaţii între aplicaţii de acelaşi tip sau de tipuri diferite; 

- Reprezentări grafice prin diagrame. 

 

MICROSOFT EXCEL 2007 – PREZENTARE 

• Avantaje utilizării aplicaţiilor tip Excel: 

 Raportările şi situaţiile de tip economic dintr-o organizaţie se elaborează, de regulă, 

periodic (zilnic, săptămânal, lunar, …), pe aceeaşi structură, doar că de fiecare dată cu alte 

valori. 

 Datele utilizate în foile de calcul pot fi reprezentate grafic, astfel încât să poată fi 

prezentate într-o formă sugestivă şi sintetică; 

 Un registru Excel poate servi la crearea unor tabele complexe şi de mari dimensiuni. 
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6.1. MICROSOFT EXCEL 2007 - INTERFAŢĂ 

 Lansare în execuţie: butonul Star → All Programs → Microsoft Office → Microsoft 

Office Excel 2007.  

 Document Excel – registru de clacul. (WorkBook) 

 Registru de calcul – creat din foi de calcul. (Sheet) 

 Elemente de interfaţă MS. Excel 2007:  

-  Butonul Office;  

-  Bara instrumente acces rapid;  

-  Bara de titlu;  

-  Panglica;  

-  Suprafaţa de lucru; 

-  Bara de stare; 

-  Barele de defilare; 

-  Butoane de vizualizare şi butoane de mărire/micşorare 5 

MICROSOFT EXCEL 2007 – INTERFAŢĂ SPECIFICĂ 

 Zona de lucru, constituită din foaia de calcul curentă. 

-  Împărţită în Linii (1 la 1.048.576) şi Coloane (16.384 notate cu litere A – XFD) 

-  Intersecţia rînd şi coloană – celulă 

-  Celula are o adresă formată din o literă şi o cifră (A15). 

-  Mai multe celule selectate formează un domeniu. A1:D7 

 Bara de formule - împărţită în Caseta Nume şi Bara de  

formule.  

- Afişarea sau ascunderea Barei de formule şi a Casetei  Nume. 

 Lista cu indicatoarele foilor de calcul. 

 Tasta F1 - Help 6 

6.2. GESTIONAREA DATELOR DIN FOILE DE CALCUL 

 Selectarea celulelor 

- Selectarea unei celule (clic în celulă) 

-  Selectarea unui bloc de celule (tasta SHIFT) 

-  Selectarea unor celule/blocuri neadiacente (tasta CTRL) 

-  Selectarea tuturor celulelor din foaia curentă (butonul de selectare totală aflat la 

intersecţia antetelor de rând şi de  coloană). 

-  Selectarea celulelor unui rând /coloană (clic pe antet) 

-  Selectarea celulelor unor randuri / coloane (tasta CTRL) 
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-  

6.3. INTRODUCEREA ŞI MODIFICAREA INFORMAŢIILOR 

 Introducerea informaţiilor se realizează prin selectarea celulei cu clic pe ea şi se tastează 

conţinutul.Acesta apare atât în celulă cât şi în bara de formule. 

Terminarea introducerii se face prin confirmarea informaţiilor introduse: 

-  Tasta Enter – celulă activă devine celula de mai jos; 

-  Clic pe butonul de pe bara de formule – celulă activă rămâne tot celula curentă; 

-  Tasta Tab – celulă activă devine celula din dreapta. 

- Tasta Esc – celulă activă rămâne tot celula curentă;  

- Clic pe butonul de pe bara de formule – celulă activă rămâne tot celula curentă.  

INTRODUCEREA ŞI MODIFICAREA INFORMAŢIILOR (2) 

 Modificarea conţinutului unei celule - două metode: 

-  Selectând celula cu clic pe ea, clic în bara de formule, apoi se operează modificarea, sau 

-  Dublu clic în celulă, apoi se operează modificarea. 

 Informaţiile în Excel - Informaţii numerice şi text. 

 Informaţii numerice – facilităţi: 

-  Completare automată 

- Umplere automată 

 Liste predefiite şi create de utilizator. 

 Vizualizare Liste / creare lista customizată 

Button Office → Excel Options→ Popular → rubrica 

Create list for use … → butonul Edit custom Lists..). 9 

INTRODUCEREA ŞI MODIFICAREA INFORMAŢIILOR (3) 

 Completarea automată a celulelor cu informaţii pe baza unei liste.  

6.4. GESTIUNEA CELULELOR /RANDURILOR / 

COLOANELOR / FOILOR ELECTRONICE DE CALCUL 

 Inserare de randuri /coloane/celule 

Fila Home → grupul Cells → din lista butonului Insert →  

Insert Rows..; Sau clic dreapta pe selecţie → Insert.  

 Inserarea foilor electronice de calcul  

Fila Home → grupul Cells → din lista butonului Insert →  

Insert Sheet sau  

Stergerea de randuri /coloane/celule 

Fila Home → grupul Cells → din lista butonului Delete→  

Delete Rows..; Sau clic dreapta pe selecţie → Delete.  
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6.5. REDIMENSIONAREA RANDURILOR / COLOANELOR 

 În cazul în care dimensiunea coloanelor ce conţin valori  

numerice este prea mică - eroarea ####.  

 Redimensionarea randurilor/coloanelor  

- Manual (click pe antet rând sau coloană) 

- Automat (fila Home → grupul Cells → butonul Format) 

 Redenumirea foi de calcul 

-  Click dreapta , Rename 

-  Fila Home → grupul Cells → butonul Format → Rename Sheet şi se tastează noul nume. 

 Formatarea celulelor (Fila Home) 

Fila Home → grupul Cells → butonul Format → Format Cells, apare caseta de dialog 

Format Cells.  

UTILIZAREA STILURILOR DE CELULĂ 

 Aplicarea unui stil  

Fila Home → grupul Styles → butonul Cell Style 

 Crearea unui stil nou  

Fila Home → grupul Styles→ se deschide lista butonului Stiluri de celule → Stil de celulă 

nou  

 Modificarea unui stil existent 

Fila Home → grupul Styles → se deschide lista butonului Stiluri de celule → Modificare 

 Ştergerea unui stil 

Fila Home→ grupul Styles → se deschide lista butonului Stiluri de celule  

UTILIZAREA STILURILOR 

 Utilizarea stilurilor de tabel  

 Aplicarea unui stil de tabel 

Se selectează tabelul (regiunea compactă de celule), fila  Home → grupul Styles → butonul 

Format as Table. 

Eliminarea stilului unui tabel 

Fila Design → grupul Table Styles -> mai multe  

optiuni -> cu clic pe clear.  

GESTINEA REGISTRULUI DE CALCUL 

 Ascundere randuri, coloane, foi de calcul  

-  Ascunderea randurilor, coloanele se realizează astfel: fila Home → grupul Cells → 

butonul Format → Hide & Unhide → ……. 
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-  Afişarea randurilor, coloanele ascunse: fila Home → grupul Cells → butonul Format → 

Hide & Unhide → ….. 

-  Ascunderea foii de calcul fila Home → grupul Cells → butonul Format → Hide & 

Unhide → ...  

 

 Protejarea datelor 

fila Home → grupul Cells → butonul Format →Lock Cell 

fila Home → grupul Cells → butonul Format →Protect  Sheet 

 Protejarea registrului de calcul 

Fila Revew → grupul Changes… 

FORMATAREA CONDIŢIONALĂ 

 Fila Home → grupul Styles → butonul Conditional Formating. 

-  Formatarea celulelor folosind scale de culoare  

-  Formatarea celulelor folosind bare de date  

-  Formatarea celulelor folosind seturile de pictogramele  

-  Formatarea folosind operatori de comparaţie  

-  Crearea propriilor reguli de formatare condiţionată  

-  Copierea / Mutarea informatiilor 

             * Tastele CTRL, SHIFT 

7. FORMULE ŞI FUNCŢII ÎN EXCEL 

AGENDA 

 Introducerea şi vizualizarea formulelor 

 Copierea formulelor 

 Referinţe absolute, mixte şi relative 

 Aplicaţie 

 Utilizarea funcţiilor 

 Funcţii de căutare 

 Functii Prelucrare Text 

 Functii conditionale 

 Aplicaţii 

 Lucrul individual 

INTRODUCEREA ŞI VIZUALIZAREA FORMULELOR 

 Toate formulele se introduc cu semnul = 

 Dacă se omite semnul =, se consideră că în celula respectivă a fost introdus un text. 
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 Formulele apar în bara de formule la selectarea celulei. 

 Operatori matematici utilizaţi în Excel: +, -, *,/, %,^. 

 Operatori de comparaţie: =, <, >, <=, >=, <>.  

 Afişare formule în celulele foii de calcul: 

Fila Formulas ->grupul Formula Auditing -> butonul Show Formulas 

 Vizualizarea formulelor din celulele unei foi de calcul ar fi necesară doar în cazul în 

care trebuie vizualizate toate formulele deodată. 

REFERINŢE ABSOLUTE, MIXTE ŞI RELATIVE 

 La copierea unei formule aceasta este adaptată pentru a corespunde poziţiei celulei în 

care va fi copiată. 

 Dacă se copiază o formulă pe aceeaşi linie, toţi indicatorii de linie din celulele formulei 

rămân neschimbaţi.Indicatorii de coloană se modifică. Şi invers. 

 Referinţele celulelor pot fi:  

- Relative – acest tip de referinţă se modifică la copierea formulei.  

-  Absolute – acest tip de referinţă nu se modifică la copierea formulei.  

-  Mixte – acest tip de referinţă îşi modifică fie numărul rândului, fie litera coloanei la 

copierea formulei.  

REFERINŢE ABSOLUTE, MIXTE ŞI RELATIVE 

 Componenta, din adresa unei celule, care rămâne constantă va fi precedată de semnul 

„$”. Exemple: 

 Relative: A1, F22 se modifică ambele componente ale adresei. 

 Absolute: $A$1, $F$22 rămân constante ambele componente. 

 Mixte: $A1, A$1, semnul $ indicând componenta din adresă care rămâne constantă 

prin copiere; 

-  $A1 - rămâne constantă litera coloanei. 

-  A$1 - rămâne constant numărul rândului. 

8.LUCRU CU DIAGRAME ÎN 

 MICROSOFT EXCEL 2007 

AGENDA 

 Realizarea unei diagrame 

 Editarea diagramei 

 Sarcini individuale 

DIAGRAME 

 Diagrama este definită ca reprezentarea grafică a datelor de tip numeric dintr-un tabel. 
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 Pentru realizarea unei diagrame se selectează acele blocuri de celule din tabel care vor 

fi reprezentate grafic. 

 Fila Insert ->grupul Charts -> …selectare tip diagramă 

 În situaţia în care utilizatorul foloseşte frecvent un anumit tip de diagramă – butonul 

Set as default Chart -> OK.  

 Pentru a realiza operaţii de tip redimensionare, copiere, mutare, ştergere, se selectează 

diagrama cu clic pe ea, apoi se execută operaţia necesară. 

(2) DIAGRAME 

 La selectarea unei diagrame din foaia de calcul:  

-  Datele sursă ale diagramei apar marcate (înconjurate in chenare) . 

-  In panglica devin disponibile instrumentele de lucru cu diagramele Instrumente 

diagramă, prin afişarea filelor Proiectare, Aspect şi Format.  

 Fila Proiectare permite realizarea următoarelor operaţii: 

-  Schimbarea tipului şi subtipului diagramei:  

-  Salvarea unei diagrame ca şablon:  

-  Comutarea intre afişarea in diagramă a seriilor pe rânduri sau pe coloane:  

-      Modificarea datelor sursă ale diagramei:  

(3) DIAGRAME 

 Fila Aspect (Layout) permite realizarea următoarelor operaţii: 

-  Formatarea unui element de diagramă selectat. 

-  Inserarea unui nou obiect grafic în /pe diagramă. 

-  Modificarea aspectului diagramei prin modificarea axelor de coordonate, etichete, nume 

de părţi ale diagramei,.. 

-  Proprietăţi şi analiza diagramei. 

 Fila Format permite realizarea următoarelor operaţii: 

-  Formatare diagramei prin culori, font-uri, efecte, aranjare, dimensiune, ... 

SELECTARE / MODIFICARE SURSĂ DE DATE 

 Caseta Interval date diagramă: vizualizarea blocurilor de date sursă şi modificarea 

acestora 

 Caseta Intrări legendă conţine lista seriilor de date reprezentate graphic. Conţine 

Butonul adăugare, editare, modificare şi Butoanele Mutare în sus şi jos.  

 Caseta Etichete axă orizontală se afişează etichetele ce vor fi dispuse pe axa 

orizontală, iar modificarea acestora se poate face din butonul Editare.  

 Butonul Celule ascunse şi goale→ permite stabilirea modului de reprezentare al 

datelor ascunse şi a valorilor nule.  
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8.1. OPERAŢII ASUPRA DIAGRAMELOR 

 Modificarea stilului diagramei – Chart Styles 

 Mutarea unei diagrame din o locaţie în alta - Move Chart 

 Selectarea diverselor elemente componente ale  

diagramei: grupul Current selection → …… 

 Formatarea unui element selectat – Fila Layout →  

grupul Current selection  

 Revenirea elementului selectat la formatarea implicită. 

 Inserarea de imagini, forme desenate şi casete de text pe diagramă: grupul Insert 

 Adăugarea/eliminarea, amplasarea şi formatarea diverselor etichete pe diagramă → 

grupul Labels  

(2) OPERAŢII ASUPRA DIAGRAMELOR 

 Adăugarea/eliminarea, poziţionarea, scalarea,formatarea informaţiilor pe axe: grupul 

Axes Fila Format permite realizarea următoarelor operaţii: 

 Formatarea cu un stil de formă predefinit a oricărui element component selectat al 

diagramei: grupul Shape Styles 

 Formatarea elementelor componente ale diagramei 

 Aplicarea de efecte textelor din diversele casete ale diagramei: grupul WordArt Style 

 Redimensionarea suprafeţei diagramei: grupul Size 
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9. REŢELE DE CALCULATOARE. 
AGENDA 

 Reţele de calculatoare 

 Tipuri de reţele de calculatoare 

 Protocoale de comunicare 

 Adresarea în reţele 

 Utilitare TCP/IP diagnosticare reţele 

DEFINIŢIA REŢELEI DE CALCULATOARE 

 Reţea de Calculatoare - o colecţie de calculatoare autonome interconectate folosind un mediu de transmisie şi o serie de 

protocoale pentru comunicare. (Andrew S. Tanenbaum). 

 Două calculatoare sunt interconectate dacă sunt capabile să schimbe informaţie între ele. Dispozitive – noduri (HOST). 

 Conectarea poate fi prin mediile de transmitere a datelor: cablu, fibra optică, radiaţii infraroşii, microunde sau sateliţi de 

comunicaţii. 

➢ Internet-ul şi WWW nu sunt RC 

 Internet-ul este o reţea de reţele 

- WWW este un sistem distribuit care funcţionează peste 

nivelul Internet-ului. 
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SISTEM DISTRIBUIT VS REŢEA DE CALCULATOARE 

 Sistem Distribuit este o colectie de calculatoare independente care apar utilizatorilor sistemului ca un singur calculator. 

(WEB). 

➢ Exemplu: Sistem Distribuit este sistemului unei banci cu zeci de filiale în întreaga lume. 

o Fiecare filială are un server ce prelucrează datele local; 

o Fiecare calculator are capacitatea de a conversa cu  

celelalte şi cu calculatorul central; 

o Tranzacţiile sunt realizate indiferent de locul în 

care a fost deschis contul clientului; 

CLASIFICARE REŢELE DE CALCULATOARE 

 Dupa aria de întindere a reţelei. 

 PAN (Personal Area Network) – imprimante, fax, telefoane, 

PDA-uri şi/ sau. Raza de acţiune a retelei este de 4-6 metri. 

 LAN (Local Area Network) – o încapere sau o cladire. Conexiunile se pot face prin cablu sau wireless. Reţeaua 

functioneaza de regula cu o latime de banda de aproximativ 100 Mbps şi sunt bazate pe tehnologia Ethernet. 

                                                 Reţea personală                   Reţea locală 
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CLASIFICARE REŢELE DE CALCULATOARE 

 Dupa aria de întindere a reţelei. 

 CAN (Campus Area Network) – campus-ul unui colegiu, complexe industriale  

sau baze militare. O astfel de retea poate include si protocoale pentru rutarea dinamică. 

 MAN (Metropolitan Area Network) – conectează doua sau mai multe retele de tip 

 LAN / CAN si acopera o suprafata de dimensiunea unui oras. 

CLASIFICARE REŢELE DE CALCULATOARE 

 Dupa aria de întindere a reţelei. 

 WAN (Wide Area Network) – reprezinta legatura dintre mai multe retele de  

tip MAN si utilizeaza de regula metodele WLAN (Wireless Local Area  

Networks) sau BGAN (Broadband Global Area Network). 

  BGAN (Broadband Global Area Network) - Sistem de 

comunicare pe bandă largă bazat pe Sputnice. Sistemul acopera 

aproape tot globul. 
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CLASIFICARE REŢELE DE CALCULATOARE 

 După metoda de conectare. 

 Ethernet (conexiune standard prin intermediul unui cablu UTP / FTP / STP) 

 Wireless LAN (Similar cu modelul Ethernet cu exceptia faptului 

ca transferul are loc prin propagarea unor semnale radio) 

 Power Line Communication (PLC) – “power line carrier”, “mains communication”, “power line telecom (PLT)”, 

sau “power line networking (PLN)” – sisteme capabile sa distribuie semnalul prin linii electronice de alimentare. 

 

CLASIFICARE REŢELE DE CALCULATOARE 

 Dupa procesele care au loc în cadrul retelei. 

 Active Networking (retele unde schimbul de informatie se face in mod egal intre statii) 

 Client-server (retele dotate cu statii care ruleaza functii de server) 

 Peer-to-peer (conexiuni intre doua statii configurate ca retele private) 
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CLASIFICARE REŢELE DE CALCULATOARE 

 Dupa topologia de retea (Wikipedia.com) 

 Magistrală 

 Stea 

 Inel 

 Completă 

 Arbore 

 

PREZENTARE 

 

METODE DE CONECTARE 

 Conectare prin cabluri metalice şi de fibră optică, 

cabluri submarine; 

 Conectare prin radio: Wi-Fi, Bluetooth; 

 Conectare prin raze infraroşii; 

 Conectare prin prin intermediul sateliților; 
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ECHIPAMENTE PENTRU REALIZAREA REŢELELOR DE 

CALCULATOARE 

 

 Placă de interfață cu rețeaua (Network Interface Card, NIC) - o piesă / un circuit electronic care permite calculatoarelor 

să se lege la o rețea de calculatoare 

 Repeater - un dispozitiv electronic care primește semnale pe care le retransmite la un nivel mai înalt sau la o putere mai 

mare, sau de cealaltă parte a unui obstacol, astfel ca semnalul să poată acoperi zone mari fără degradarea calității sale 

ECHIPAMENTE PENTRU REALIZAREA REțELELOR DE CALCULATOARE 

 Router – un dispozitiv hardware sau software care conectează două sau mai multe rețele de calculatoare bazate pe “mutarea 

de pachete“ (packet switching). 

PROTOCOL 

 Un Protocol reprezintă un standard sau o convenţie asupra modului de desfăşurare a unui anumit lucru. 

 În reţele de calculatoare protocoalele permit calculatoarelor să comunice între ele printr-un limbaj comun. 

 Suită de protocoale – mai multe protocoale ce lucrează împreună. 

1
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SUITA DE PROTOCOALE TCP / IP 
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DHCP 

 Dynamic Host Configuration Protocol – alocare dinamică de IP adrese. 

 Operează după modelul client – server. 

 DHCP faze: DORA 

 Discovery 

 Offer 

 Request 

 Acknowledgement 

DHCP FAZE 
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HTTP 

 Hipertext Transfer Protocol 

 Protocolul HTTP se defineşte ca un protocol de transfer de 

fişiere hypertext, care nu sunt altele decât paginile Web. 

 Asigură traficul Web. 

 

 

ROTOCOALELE POP (109,  
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10. INTERNET. POŞTA ELECTRONICĂ. MS OUTLOOK 

AGENDA 

 Internet 

 Servicii Internet 

 Poşta electronică 

 Aplicaţii pentru poşta electronică 

 Utilizare MS Outlook 

 Browsere Web 

 Căutarea în Internet. Motoare de căutare. 

INTERNET 

 Internet defineşte un sistem mondial de reţele de calculatoare interconectate, care 

înlesneşte serviciile de comunicare a datelor: transferul de fişiere, de conţinut, 

email, IRC 

SERVICIILE OFERITE ÎN INTERNET 

 Serviciul de poşta electronică (e-mail). 

 Serviciul de transferări de fişiere (FTP). 

 Serviciul de acces la calculatoare server (Telnet) 

 Serviciul de conversaţii, cu suport Internet (IRC) – chat,  skype, messenger, forum 

 Serviciul WWW (World Wide Web) –sistem de pagini de tip hipertext legate ele între 

ele care pot fi accesate prin Internet. Web Site. Web Server. 

 Serviciul de e-commerce - magazinelor electr. virtuale 

 Sistemul de tip formulare în Internet – implementarea interactivităţii. feedback, oferte. 

 În serviciul baze de date on-line – utilizatorii pot interoga, analiza sau modifica date 

online 

CONEXIUNEA LA INTERNET 

 Calculator cu placa de reţea 

 Mediu de comunicare – Cablu, WiFi, …. 
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 Dispozitiv de interconectare – modem, hub, switch, router. 

 Internet Service Provaider – Starnet, Moldtelecom,… 

 Conexiune dial-up (linie telefonică). 

 Fibră optică.  

 Cablu de reţea (UTP) 

 Cablu coaxial (TV). 

 Modem Wifi, router WiFi,… 

 Navigator Web (Browser Web) – Chrome, IE, Mozila Firefox, Opera, Safari, …  

E-MAIL 

 Funcţionarea serviciului de email este inspirată din sistemul poştal clasic.  

 Se alcătuie scrisoarea adresă destinaţie şi recepţie. (program).  

 Oficiu poştal = server de mail de ieşire şi server de mail de intrare. 

 Protocol SMTP (Simple Mail Transport Protocol) –expediere scrisoare de la sursă la 

server şi între servere. 

 Protocol POP (Post Office Protocol) – responsabil citire şi livrare la destinaţie mesaj. 

PROGRAME DE POŞTA ELECTRONICĂ 

 Program email – numit client de poşta electronică (MUA),specializat în managementul 

mesajelor electronice 

 Poate transmite, primi, filtra mesajele în funcţie de anumite criterii. 

 Clientul (MUA) interacţionează direct cu un Mail Transfer Agent (MTA) pentru 

primirea şi trimiterea mesajelor folosind protocoalele POP3 (Post Office Protocol) şi 

IMAP (Internet Message Access Protocol). 

 Exista o varietate de programe de email, cu interfete bazate pe meniuri si comenzi sau 

cu interfete vizuale. 

 Programe de poşta electronică prin Internet. 

 MS Outlook. 10 

MS OUTLOOK 
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 Outlook este un program de comunicare şi gestionare a informațiilor personale. 

 MS Outlook – permite scrierea, trimiterea, primirea, citirea de e-mail 

 MS Outlook – permite gestiune unei liste de contacte. 

 MS Outlook – permite gestiune calendar  

 MS Outlook – permite gestiune sarcini 

 MS Outlook – permite gestiune activităţi 

CONFIGURARE MS. OUTLOOK 

 Meniul Tools, selectati Account Settings in fereastra nou deschisa dati click pe butonul 

New din fila Email. 

 In fereastra urmatoare selectati Microsoft Exchange, POP3, IMAP, or HTTP si apoi 

apasati Next… 

 Bifati optiunea Manual configure server settings…… apoi click pe Next… 

 Bifati optiunea Internet email si click pe Next… 

 In fereastra nou deschisa completati datele ca in imaginea de mai jos dar cu datele 

domeniului dvs. Apoi dati click pe butonul More Setting... 

UTILIZARE MS. OUTLOOK 

 Lucru cu poşta electronică. 

- Creare nou mesaj 

-  Trimitere mesaj 

-  Atasare fisier la mesaj 

-  Citire mesaj 

 Gestionarea timpului – calendarul 

-  Trimitere calendar prin poşta electronică  

-  Cărţi de vizită electronice  

 Gestiunea contactelor 

-  Inseraţi contacte 

 Gestiunea de evenimente / activităţi 

-  Inseraţi activităţi. 
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BROWSERE WEB 

 Programul client folosit pentru a avea acces la serviciul WWW / pentru a obţine 

informaţia solicitată de user. 

 Permite afişarea informaţiilor sub formă de text, grafică, video, audio precum şi a altor 

tipuri de informaţii aflate pe o pagină din spaţiul WWW. 

 Statistici utilizare browsere 

11. UTILIZARE MS POWERPOINT 2007 LA 

CREAREA PREZENTĂRILOR ELECTRONICE 

AGENDA 

 Posibilităţi MS PowerPoint 

 Elemente de interfaţă 

 Diapozitive 

 Animaţii 

 Inserare obiecte 

 Vizualizare prezentare 

MS POWERPOINT 2007 

 Aplicaţie utilizată pentru crearea prezentărilor electronice cu ajutorul diapozitivelor. 

 Conţinutul unui diapozitiv (slide) poate fi reprezentat prin: Informaţii numerice, textuale, 

imagini grafice, obiecte, sunete, videoclipuri imagini, etc 

 Un document PowerPoint 2007 este numit prezentare electronică şi este reprezentată de 

o serie de diapozitive grupate împreună după o tematică. (.pptx) 

 Pentru a lansa în execuţie: Butonul Start → All Programs → Microsoft Office → 

Microsoft Office PowerPoint 2007. 

11.1. ELEMENTELE DE INTERFAŢĂ 

 Butonul Office 

 Bara de elemente cu acess rapid – poate fi particularizată. 

 Bara de titlu.  



52 

 

 Butoanele de minimizare, maximizare şi închidere a ferestr. apl 

 Panglica ce conţine implicit file: Home, Insert, Design, Animation, Slide Show, Review, 

View. Poate fi adăugată Developer. Apare la selectare obiect – fila Format. 

 Suprafaţa de lucru. 

 Bara de stare. 

 Butoane de vizualizare 

 Butoane de mărire / micşorare a suprafeţei de lucru.  

11.2. SUPRAFAŢA DE LUCRU 

 Panoul Diapozitive (Slide Pane) în stînga 

 Diapozitive. 

 Schiţă.  

 Diapozitiv Curent cu titlu si conţinut în centru,  

 Panou notiţe (Note Pane). 

 Panou activităţi (Task pane) în dreapta, apare la Insert -> but. Clip Art. 

 Dacă Panoul Diapozitive nu este vizibil, fila View -> grupul Prezentation View -> but. 

Normal 

 Paginilor din Panoul de notiţe le poate fi schimbat aspectul ->Fila View -> Notes Master, 

Notes Page. 

 Paginile de notiţe pot fi tipărite - > Print Properties. 

11.3. CREAREA UNEI PREZENTĂRI 

Înainte de a începe crearea unei prezentări:  

 Să fiţi documentaţi referitor la subiectul pentru care veţi face prezentarea; 

 Să cunoaşteţi grupul ţintă cui vă adresaţi; Structura pe care o dăm diapozitivelor: clară, 

scurtă, concisă, la obiect; Să aveţi stabilit tipul de informaţii din fiecare diapozitiv, pentru 

a vă alege şablonul de conţinut potrivit; 

 Să cunoaşteţi forma artistică de prezentare – design-ul prezentării; Să nu folosiţi 

şabloane de design încărcate - cel mai bine este să vă creaţi un şablon propriu sau sa 

utilizaţi logo-ul companiei într-un colţ al ecranului; 
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 Pentru a crea o prezentare urmaţi paşii: Clic pe Buton Office -> New.  

EXPUNEREA UNEI PREZENTĂRI 

 Expunere pe ecran (On screen presentations) – pe monitorul calculatorului, sau pe un alt 

ecran prin intermediul videoproiectorului. 

 Folii transparente pentru retroproiector (Overhead transparencies); 

 Fotodiapozitive de 35mm; 

 Diapozitive listate pe hârtie (Paper printouts) –pentru verificare şi discuţii; 

 Diapozitive imprimate (Handouts) – pagini ce conţin mai multe diapozitive 2,4,6, oferite 

auditoriului; 

 Pagini de note (Notes) – pagini ce conţin diapozitivul însoţit de o zonă de note; 

 Vizualizare schiţată (Outline) Fila Design ->grupa Page Setup -> but. Page Setup  

OPERAŢII ÎN PREZENTĂRI ELECTRONICE 

 Deshidere în mod protejat / neprotejat 

 Protejarea prezentării prin parolă la deschidere şi/sau la modificare. Save as -> tools -

>General Options 

 Marcare ca final 

 .. save as ->tip fişier (Web) 

 Opţiunea Convert 

 Opţiunea New  

 Opţiunea Prepare 

 Butonul PowerPoint Options 

DIAPOZITIVE 

 Fiecare diapozitiv este alcătuit din titlu şi conţinut; 

 Inserare diapozitiv nou: Home ->grupa Slides ->New Slide / sau CTRL + M. 

 În partea de conţinut pentru fiecare diapozitiv pot fi inserate diferite obiecte, în 

dependenţă de tip. 

 Diapozitive cu aceleaşi teme şi/sau teme diferite fila Design -> grupul Themes ->click 

dreapta themă selectată, Apply for selected Slides. 
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 Adaugare diapozitive din altă prezentare Home ->grupa Slides ->New Slide ->Reuse 

Slides 

 Modificarea aspect diapozitiv Home ->grupa Slides ->Layouts  

(2) DIAPOZITIVE – TIPURI DE OBIECTE 

Fiecare diapozitiv dintr-o prezentare poate avea unul  

sau mai multe elemente numite obiecte. 

 Casete text şi imagini  

 Liste cu marcatori  

 Tabele 

 Diagrame 

 Imagini grafice 

 Imagini din fişiere 

 Imagini ClipArt 

 Audio şi videoclipuri 

11.4. MODIFICAREA /FORMATAREA OBIECTELOR 

 Copierea, mutarea, ştergerea obiectelor se execută: 

-  Fie cu ajutorul butoanelor de comenzi din fila Home → grupul  Clipboard  

-  Fie prin folosirea meniului de context obţinut prin clic dreapta mouse pe obiectul 

respectiv. 

-  Inserare Specială (Paste Special) 

 Formatarea obiectelor – aspect, culori, dimensiuni,.. 

-  Fila Home→ Font şi Paragraph -> propr. Necesare 

- Prin utilizarea unor file care apar pe Panglică, în momentul în care se selectează 

un element /obiect, ex. tabel, diagramă,... 

-  apelarea comenzilor specifice fiecărui obiect selectat, ce apar în meniul de 

context, la clic buton dreapta mouse pe obiect  

ADAUGARE TEXT ÎN DIAPOZITIV 
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 Text de substituenţi (placeholder) – casete text propuse de anumite şabloane pentru 

aspect diapozitiv (aceste tipuri de substituenţi se aleg din Home ->Slides->Layout)  

 Text într-o casetă text (Insert ->Text ->Text box)  

 Text ce poate fi adăugat în o formă desenată (Insert -> Ilustrations -> Shapes)  

 Text WordArt – text decorativ (Insert ->Text ->WortArt)  

MODALITĂŢI DE VIZUALIZARE PREZENTARE 

Fila View ->Prezentation Views -> tip Vizualizare 

 Normal (Normal) se deschide implicit la deschiderea aplicaţiei. 

 Sortare diapozitive (Slide Sorter). Acest mod de vizualizare afişează pe tot ecranul toate 

diapozitivele prezentării, într-o versiune miniaturizată 

 Notes Page  Slide Show. 
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SARCINI DE LUCRU 

SARCINA INDIVIDAULA NR. 1 

 

- Creaţi un document nou. Scrieţi un text din 5 paragrafe.  

- Semnati documentul cu numele si prenumele d-stra.  

- Salvati documentul cu titlul "lectia1.doc" în directoriul propriu, creat  

de d-stra. 

- Faceţi o copie a acestui document. (Сохранить как…). Setati  

marginile documentului  

o 2 sus,  

o 2 jos 

o 2.5 stinga 

o 1.5 dreapta. 

- Paragraful 1 să fie aliniat stânga, la o distanţă de 2 cm de marginea  

dreaptă a foii, 1 cm de marginea stângă, iar distanţele de deasupra şi  

dedesubt să fie de 1,5pt. Lăsaţi o distanţă de două randuri intre liniile  

paragrafului. 

- Paragraful 2 să fie aliniat la centru, iar prima linie să fie indentată cu  

5 cm spre interior faţă de celelalte. Distanţa dintre rânduri este de  

1,20. 

- Paragraful 3 este indentat inspre exterior in ambele capete cu 0,5 cm,  

aliniat justify (stânga-dreapta), distanţa de deasupra si dedesubtul  

paragrafului este de 6pt. 

- Paragraful 4 este indentat cu 1 cm inspre stanga in ambele capete. 

- Paragraful 5 are textul agăţat cu 2 cm înspre interior, iar distanţa  

dintre rânduri de 2.0 
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SARCINA INDIVIDAULA NR. 2 

Creaţi un document nou. Scrieti un text din 3 paragrafe. Semnati documentul cu 

numele si prenumele d-stra. Salvati documentul cu titlul "Lectia2" în directoriul 

propriu, creat de d-stra. Faceţi o copie a acestui document. Setati marginile 

documentului 2 sus, 2 jos, 2.5 stinga, 1.5 dreapta. 

1. Stabiliti (scoateţi) parola la deschiderea documentului. Stabiliţi scoateţi) parola la 

redactarea documentului. 

2. Acordati permisiuni de modificare pentru paragraphul 2 din documentul creat. 

3. Setaţi opţiunile necesare pentru a crea o copie de rezervă pentru documentul creat 

cu denumirea Lectia2.wbk şi salvaţi-o în dosarul dumneavoastră. 

4. Modificati timpul de AutoRecuperare la 5 min.  

5. Modificaţi directoriul implicit pentru salvarea documentelor în directoriul creat de 

d-stra. 

6. Realizati comutarea intre 2-3 documente Word. 

7. Cercetaţi diferite moduri de selectare a unui caracter, cuvint, text, linie de text, 

paragraf, intreg document. Cercetaţi diferite moduri de stergere a unui caracter, 

cuvint, text, linie de text, paragraf, intreg document. 

8. Afisati deasupra (dedesupt) panglicii bara de elemente cu acces rapid. 

9. Dezactivati (activaţi) utilizarea mini barei de elemente. 

10. Inserati în document 5 simboluri speciale Ω Σ μ € ©. 

11. Selectati apoi mutati prima linie din document la sfirsitul documentului. 

12. Copiati de 3 ori prin 3 modalitati diferite acelasi paragraf. 

13. Selectati un abzat, o propoziţie cu ajutorul mouse-ului, cu ajutorul tastelor prin 

modalitati diferite. 

14. Deplasati-vă cu ajutorul combinatiilor de taste la începutul documentului si la 

sfirsitul documentului. 

15. Salvaţi documentul sub numele Lectia2.1.doc. Ascundeti citeva cuvinte din 

document apoi Inspectati documentul pentru date ascunse.  

16. Inserati un obiect sau un text din alt fisier in documentul lectia2.1.doc. 

17. Copiati (Mutati) liniile 1 si 3 din documentul Lectia 2 în documentul Lectia 2.1 

folosind 2 modalitati diferite. 

18. Înlocuiti în tot documentu un cuvint cu altul. Găsiti cu ajutorul comenzii un 

cuvint cautat. 

19. Formataţi textul din prima linie a documentului primele 2 cuvinte cu litere 

aldine, linia 2 ultimele 2 cuvinte cu litere cursive, linia 3, 2 cuvinte la mijloc cu 

litere subliniate. 
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SARCINA INDIVIDAULA NR. 3 

1. Scrieti în document un text din 4-5 paragrafe extins pe 2 foi. Salvaţi 

documentul sub numele Lectia3.doc în directoriul propriu. Stabiliti fiecarui 

paragraf titlu. Ex. “Titlu 1” 

2. Transformati textul introdus în document astfel: prima propozitie toate 

cuvintele cu litere mari (de tipar), propozitia a doua fiecare cuvint trebuie sa 

se inceapa cu litara mare, in propozitia a treia sa fie si litere mari si mici. 

3. Formatati paragraful 2 dupa cum urmeaza: prima propoziţie cu aldine, 

urmatoarele 2 cursive, restul subliniate, copiati formatul propozitiei 2 pentru 

propozitia 3 si 4, apoi pentru propozitia 4 anulati formatarea data. 

4. Aplicati stiluri pentru titlurile paragrafelor cu stilul Heading 1 si/sau cu 

Heading 2. 

5. Modificati formatul unui stil (spre exemplu pentru stilul Heading 2). 

6. Setaţi formatarea paragrafelor. Indetare pîna şi dupa paragraf cu 6cm, 

prima propozitie în paragraf să fie indentata cu 1.2 cm., indentarea din stinga 

si din dreapta cu 1cm. Stabiliti distanta între rinduri de 1.5 cm in tot textul. 

7. Definiti tabulatori: La stanga, La centru, La dreapta. Modificat/Eliminati 

un tabulator. 

8. Introduceti o listă marcata cu buline şi alta numerotată cu litere mici ale 

alfabetului latin. Lista trebuie sa contina minim 5 elemente. 

9. Setati optiunile necesare pentru indentarea si formatarea listei. 

10. Adaugati diferite tipuri de borduri si umbre pentur fiecare paragraf. 

11. Stabiliti numerotarea paginilor jos, in coltul drept. 

12. Scrieti în partea de antet data, ora, nume companie si partea de subsol nr. 

pagina. 

13. Modificarea antetului si subsolului. 

14. Copiati formatul de la un text la un alt text. 

15. Scrierea sau înregistrarea unei macrocomenzi in care in un document se 

insereaza un text din alt  

fisier sau se insereaza un antet si un subsol.  

16. Crearea marcaj in document. Crearea unui cuprins in baza stilurilor create. 

Crearea unui index.  

17. Adăugarea/Modificarea unei inscriptionări text la un document (Model). 

18. Adăugarea/Modificarea unei teme la un document. 

           19. Creati un document exact ca si desenul de mai jos. Borduri şi  umbrire. 

Simboluri special 
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SARCINA INDIVIDAULA NR. 4 

1. Scrieţi o scrisoare unei prietene/ prieten. Folosiţi facilităţile de formatare din 

Word şi realizaţi un design adecvat al documentului.Salvaţi fişierul sub numele 

Scrisoare1. Creaţi o copie a fişierului salvat cu numele Scrisoare2. Modificaţi 

unele texte din conţinutul scrisorii şi salvaţi modificările. Dacă sunteţi conectat 

la Internet incercaţi să trimiteţi scrisoarea (fişierul Scrisoare2) prin e-mail la o 

adresă cunoscută. 

2. Realizaţi o carte de vizită. Salvaţi documentul cu numele CarteVizita. 

3 Scrieţi un CV (curriculum vitae) pentru dvs. sau pentru o cunoştinţă. Salvaţi 

documentul intr-un fişier cu numele CV. 

4. Creati un tabel asemanator tabelului dat. 

 

6. Adaugati/stergeti pentru tabelul dat o coloana. Adaugati/stergeti pentru tabelul 

dat o linie. 

7. Selectati pentru tabelul dat o linie/o coloana, mai multe coloane, mai multe 

rinduri. 

8. Divizati o careva celula in doua celule 

9. Modificati lăţimea coloanei şi inălţimea randului prin 2 modalitati 

10. Faceti ca coloanele dintr-un tabel să se potrivească automat la conţinut. 

11. Stabiliti alt tip de chenar pentru tabel, setati o umbrire. 

12. Introducerea in document a imaginilor asemanatoare imaginii de mai jos. 
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13. Crearea unei diagrame in baza datelor din tabelul de mai SUS  

14.Inserati casete de text. Schimbati orientarea textului. 

15. Folositi Text decorativ 

16. Editarea/Modificarea graficii din document. 

17. Setati modul de tiparire a documentului 2 pagini pe foaie. 

18. Vizualizati documentul inainte de tipar. 

19. Verificarea ortografică a documentului 

20. Intr-un document nou numit tabel.doc, realizaţi următoarele operaţii: 

- Inseraţi un tabel cu cinci randuri şi patru coloane. Scrieţi in antetul tabelului 

următoarele cuvinte – Nr. Nume, Prenume, Clasa. Completaţi tabelul cu date 

corespunzătoare. 

- Inseraţi intre randul trei şi patru un rand gol. Adăugaţi valori şi pe acest rand. 

- Modificaţi aspectul antetului tabelului astfel: fundal gri deschis, culoarea 

textului roşu inchis, font Calibri,dimensiune 15, text ingroşat şi aliniat la centru 

atat pe orizontală cat şi pe verticală. 

- Modificaţi restul tabelului astfel: liniile verticale verzi,punctate, liniile 

orizontale invizibile, textul scris cu culori diferite pe fiecare coloană, font 

Calibri, dimensiune 13. 

- Inseraţi in stanga tabelului o coloană goală, imbinaţi celulele acesteia şi scrieţi 

in celula obţinută textul “Date elevi”, aliniat la centru pe orizontală şi sus pe 

verticală. Rotiţi textul cu 270 de grade şi coloraţi Fundalul celulei cu o culoare 

la alegere. Sortaţi ascendent datele din tabel. Ingroşaţi chenarul exterior al 

tabelului. 

- In documentul tabel.doc, pe o pagină nouă inseraţi un tabel cu şapte coloane şi 

cinci randuri. Copiaţi in primele trei coloane datele din tabelul creat la punctual 

anterior, referitoare la Nr., Nume şi Prenume. Mai adăugaţi in tabel pe 

coloanele următoare textele Notă Romană, Notă matematică, Notă 

geografie/istorie şi Medie admitere. Completaţi notele obţinute de elevi şi 

folosind formule de calcul in tabel calculaţi mediile obţinute de aceştia cât şi 

cea mai buna nota. Sortaţi datele descendent. 
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PSARCINA INDIVIDAULA NR. 5 

1. Lansaţi în execuţie Excel şi vizualizaţi registrul de calcul la 50% prin 

intermediul comenzii 

Panoramare. 

2. Repetaţi acţiunea pentru a vizualiza la 150% şi apoi alegeţi din caseta 

Panoramare 100%. 

3. Inseraţi două foi în registrul de calcul între Foaia2 si Foaia3. 

4. Redenumiţi Foaia1 în „Stat” şi Foaia2 în „Diverse”. 

5. Redenumiţi Foaia3 în „Salariu”. Mutaţi această foaie pe primul loc din registrul 

de calcul. 

6. Mutaţi Foaia5 pe ultimul loc din registrul de calcul. 

7. Aduceţi pe rând în prim-plan foile de calcul „Stat” şi „Diverse”. 

8. Selectaţi celula W19 la care ajungeţi prin intermediul barei de derulare 

verticală. Activaţi această celulă. 

9. Reveniţi în celula A1 cu ajutorul casetei de nume. 

10. Selectaţi toate celulele de la A1 la C15 şi simultan domeniul B4: F8. 

11. Salvaţi registrul de calcul cu numele „Angajati” în folderul alocat dvs. 

12 In foaia de calcul Stat, începand din celula A4, introduceţi tabelul cu urm. 

titluri de coloana: 

Nr. Crt. Nume Prenume Sal. Tarifar 

12. Sub titluri în tabel se introduc datele a 10 persoane, efectuând calculele 

următoare: salariul tarifar minim /maxim, suma totala a tuturor salariilor, 

salariul mediu, nr. de angajaţi. 

14. Nr. Crt. se introduce ca serie numerică de numere în progresie aritmetică. 

15. Se sortează tabelul după Nume, crescător. 

 

16. Să se realizeze o diagramă de tip Structură radială (Pie) care să reprezinte 

Salariile nete ale angajaţilor. 

 

17. Treceţi în foaia de calcul Diverse. Completati foia de calcul cu informatie 

diversa. 

18. Faceţi o copie a fişierului pe care o denumiţi „Salariu_copie”. 

19. Stabiliti parola pentru foia de calcul „Stat”. 

20. Salvati modoficarile si parasiti Aplicatia Ms. Excel 
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SARCINA INDIVIDAULA NR. 6 

1. O firmă vinde televizoare în rate. Să se determine rata lunară, totalul 

de plată şi să se construiască tabela amortizării în cazul în care un cumpărător 

achiziţionează un televizor în valoare de 5 000 lei. Se va considera că a fost 

plătit un avans de 500 lei şi că televizorul va fi plătit în 12 rate lunare cu o 

dobândă de 40%. Să se construiască o foaie de calcul cu ajutorul căreia să se 

calculeze automat aceste valori. La proiectarea foii de calcul se va avea în 

vedere că dobânda se poate modifica în timp. 

Se va crea următoarea foaie de calcul (figura 6.9.1): 

Prima parte a foii de calcul conţine datele de intrare în problemă: numele 

cumpărătorului (B1)”Popescu Florentina ”, valoarea obiectului cumpărat 

(B3) „5000lei”, data de cumpărare (B4) „7/1/2001”, dobânda anuală 

(B5)”40%” şi numărul de rate (B6) „12”, (B7) Avans 500 lei. 

În a doua parte a foii de calcul se va calcula rata lunară ce trebuie plătită în 

ideea că dobânda nu se va modifica. Tot aici se calculează totalul de plată şi 

valoarea totală a dobânzii. Se vor introduce următoarele formule: 

B9: PMT(B5/12,B6,B3-B7)(rata lunară). Funcţia PMT calculează suma 

care trebuie achitată periodic pentru un împrumut/economie, dacă se indică 

dobânda, numărul perioadelor de plată. 

 Figura 6.9.1. Prezentarea datelor în FOIA DE CALCUL 

B10: B11–B3 (totalul de plată - valoarea iniţială). 

B11: B6*B9+B7 (numărul de rate*rata lunară ‡ avansul). 

În a treia parte a foii de calcul se va crea un tabel care va conţine pentru 

fiecare lună dată la care trebuie plătită rata, rata dobânzii în luna respectivă, restul 

de plată, valoarea dobânzii şi rata lunară. Restul de plată în luna a doua este egal 

cu restul de plată în prima lună‡valoarea dobânzii 

- rata lunară. Se vor introduce următoarele formule: 
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B14: DATE(year(B$4),MONTH(B$4)+A14,DAY(B$4)).  

D14: B3-B7. 

         D15: D14+F14–E14. 

E14: PMT(C14/12,B$6-A14+1,D14). 

F14: D14*C14/12. 

Se copiază pe coloană formulele din celulele D15, E14, F14, A14. În 

domeniul A14:A25 se generează o serie numerică care începe de la valoarea 1 şi 

cu pasul seriei de 1. 

2. Utilizarea funcţiilor de căutare - VLOOKUP şi HLOOKUP. 

VLOOKUP (valoare, domeniu, index-linie, tip-

căutare) HLOOKUP (valoare, domeniu, index-

coloană, tip-căutare) 

Sa consideram un exemplu simplu, cel al unei liste de persoane, în care numele 

şi prenumele fiecărei persoane este însotit de profesia sa, astfel: Ion: medic; 

Lidia: asistent medical; Vasea: laborant; Jan: asistent medical;……Deja a 

apărut o repetare a profesiei. În cazul în care lista este lunga, tastarea textului 

„asistent medical” si altor profesii ar putea fi făcuta cu greseli. 

O cale de evitare a posibilelor nereguli o constituie folosirea functiei predefinite 

VLOOKUP. Ea a fost creata pentru a caută o anumita secventa în cadrul unei 

coloane a tabelului si a returna valoarea corespunzătoare (de pe acelasi rând) din 

alta coloana, conform sintaxei =VLOOKUP(secventa, zona tabelului, 

deplasare) Efectul utilizării functiei este următorul: atunci când functia gaseste 

secventa căutata într-o celula din coloana de căutare, se va retine pozitia rândului, 

apoi se efectuează deplasarea indicata pe acel rând, returnând în final continutul 

noii celule. 

Pentru un exemplu concret, sa plasam în domeniul A1:B3 valorile nr. respectiv 

profesia iar în domeniul A4:B5 nr. respectiv sexul. Sa redenumim cele doua 

domenii (cu comanda Inserare? Nume, evident, după selectarea fiecăruia) 

PROFESIA, respectiv SEXUL. Sa completam acum, începând cu celula D1, 

următoarele date: nume, cod profesia, sexul, figura de mai jos. 

Celulele de pe coloanele G si H vor fi completate automat. De exemplu, în celula 

G1 se va introduce formula =VLOOKUP(E2,PROFESIA,2) iar în H1 formula 

=VLOOKUP(F2,SEXUL,2) 
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3. Un registru Excel este alcătuit din două foi de calcul. O foaie de calcul - 

cursuri – conţine cursurile de schimb pentru mai multe valute, cealaltă foaie – 

casa – este folosita pentru a calcula echivalentul în lei al sumelor schimbate. 

Foaia de calcul cursuri are structura din figura de mai jos. 

 

 

În coloana Nume se introduce numele persoanei care realizează o 

tranzacţie, iar în coloana Tranzacţie se introduce tipul tranzacţiei efectuate. 

Valorile permise în această coloană sunt C – pentru cumpărare şi V – pentru 

vânzare. În coloana Tip valută se introduce numele monedei schimbate (atenţie: 

numele monedei trebuie să fie identic cu cel din foaia de calcul cursuri). 

În coloana Suma schimbată se introduce suma care se schimbă. În coloana 

Echivalent lei se calculează echivalentul în lei al sumei schimbate (în funcţie de 

valută, suma schimbată şi tipul tranzacţiei). Formula utilizată în celula E2 este: 

=D2*VLOOKUP(C2, cursuri!A$2:C$9, IF(B2. „C”,2,3)), Se copiază formula 

pe coloană şi, pe măsura ce se introduc date în foaia de calcul, echivalentul în lei 

al sumei schimbate se va calcula automat. 

4. Să se creeze un tabel „Vânzările de produse de la o societate comercială”, 

pentru mai multe zile, ce au valorile (în lei) din tabel „Denumire produs, 

Preţ, Ziua, Vânzări”. Să se calculeze: vânzarea medie zilnică, vânzarea 

minima, vânzarea maximă, vânzarea totală, preţul total, preţul mediu, 

preţul minim, preţul maxim. 

4.1 Completaţi tabelul de mai jos, în care ultimele două coloane (TVA si Preţ 

cu TVA) şi ultimul rând (TOTAL) sunt calculate cu ajutorul unor formule. 

1.1 Inseraţi între rândul 2 şi 3 o linie cu articolul Telefon în valoare de 
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325 lei. Reflectaţi modificările. 

1.2 Calculaţi cu ajutorul funcţiilor:Suma  totala a cheltuielilor (cu ajutorul 

funcţiei SUM). Media cheltuielilor (cu ajutorul funcţiei AVERAGE). 

Determinaţi suma cea mai mare, respectiv, cea mai mica. Apoi introduceţi 

valorile obţinute în foaia de calcul. 

Tema propusă: 

1. Să se realizeze registrul Proiect şi in prima foaie de calcul să se creeze 

tabelul cu următorul cap de tabel: 

Nume 

salariat 

Ore 

lucrate 

Tip 

activita 

te 

Cost/s 

alariat 

Cost 

materia 

le 

Total 

activita 

te 

1. Sub antet se introduc datele a 10 persoane, efectuând calculele, ca în figura 

următoare: 

2. Tabelul conţine formule după cum se vede în figura următoare: 

 

1. Extrageti valorile distincte din coloana Tip Activitate. 

2. Construiti un Tabel Pivot in baza tabelului de mai sus. 

3. Analizati daca exista valori dublicate in fiecare coloana a tabelului de mai 

sus. 

4. Aflati valoarea totala a materialelor, pentru fiecare tip de activitate in parte. 

(subtotaluri). 

5. Să se realizeze o diagramă de tip Structură radială (Круговая) pe care 

să se reprezinte Total activitate pentru fiecare salariat şi o diagramă de 

tip Coloană (Гистограмма) pe care să se reprezinte Cost materiale şi 

Cost salariat pentru fiecare activitate în parte. 

6. Să se modifice tabelul creat la lectia precedenta după schema şi 

figura dată: Să se efectueze calculele necesare 
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SARCINA INDIVIDAULA NR. 7 

1. Să se realizeze o diagramă de tip Structură radială (Круговая) care să 

reprezinte Salariile nete ale angajaţilor. (Aplicatia realizata in lectia 5). 

2. Maketati diagram realizata prin: titlu, denumire axe, legenda,…. 

3. Modificati tipul diagramei. Copiati diagrama pe alta foie de calcul. 

4. Analizati toate tipurile de diagrame. 

5. Aplicatie: Reprezentaţi grafic procentul de participare a partidelor politice în 

Parlament. 

6. Exportul care se înregistrează pe plan mondial se poate exprima în procente astfel: 

UE – 20%, SUA – 16%, Canada – 5%, Hong Kong – 5%, China - 4%, Rusia – 2%, 

Elvetia – 2%, Japonia – 12% şi alte ţări – 34%. Reprezentaţi aceste procente sub 

forma unui grafic circular. 

7. Să se reprezinte grafic pentru datele din tabelul de mai jos: 

a. Cantităţile vândute în cei trei ani. 
b. Evoluţia cifrei de afaceri pe produse comparativ, evidenţiind ponderea 

valorii fiecărui an în totalul celor trei ani. 
c. Cifra de afaceri din ultimul an, aferentă celor cinci produse, evidenţiind 

valoarea aferentă fiecăruia în valoarea pe total produse. 

 

 Cantitatea 

vândută 

(buc.) 

Preţul de 

vânzare 

(lei) 

Cifra de afaceri 

Prod 2001 200

2 

2003 2001 2002 2003 2001 2002 2003 

P1 300 320 350 750 780 800 1200

0 

12500 13000 

P2 350 390 280 800 820 780 1300

0 

13500 14000 

P3 380 400 320 690 750 780 1500

0 

16000 17000 

P4 400 420 450 800 820 830 1550

0 

18000 17500 

P5 450 480 380 790 850 870 1600

0 

16000 19000 
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8. Foaia de calcul prezentată în figura de mai jos conţine cheltuielile pe care le face o 

firmă pentru a-si face reclamă. În celula C4 vom introduce formula =B4/B$8 şi 

copiem formula în domeniul C5:C7. 

Să se reprezinte într-o diagrama de tip График structura acestor cheltuieli 

(numai procentele). 

9. Foaia de calcul prezentată în figura de mai jos conţine nivelul stocurilor 

pentru articolele realizate de o fabrică de încălţăminte pe durata unei luni. 

Să se reprezinte sub forma grafică nivelul stocurilor pentru cele trei articole prin-un 

grafic de tip ..... 

10. Foaia de calcul arătată în figura de mai jos conţine numărul de calculatoare 

asamblate într-o fabrică în trei intervale de timp: de la ora 8 la ora 16, de la 

ora 16 la ora 24 şi de la ora 24 la ora 8, de luni până vineri. 

 
Să se reprezinte într-o diagrama numărul total de calculatoare asamblate la 

sfârşitul fiecărei perioade. 

11. Din cadrul diagramei obtinute stergeti seria de date pentru ……(perioada 

16:00-24:00). 
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